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1．はじめに 

 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カスト

マニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブルシュー

ト・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、E-mail でお

送りしています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配信希望」と明記して、お名

前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

本プロトコルは、アジレント 遺伝子発現マイクロアレイを用いた 1 色法解析における、推奨ラベル化、ハイ

ブリダイゼーション、洗浄、スキャニングと数値化の手順を記載しています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 サンプル 1 アレイで、シグナル強度を測定 

 

 

Ver.6.9_JP での更新点 

⚫ 詳細なスキャナの起動手順と SureScan で起動エラーが出た際の対処法を追記しました。 

⚫ Gene Expression Large Volume Hybridization kit の記述を除きました。 

⚫ チャンバをオーブンにセットする際の補足説明を追加しました。 

⚫ 実験に使用する Agilent キット fragmentation buffer のチューブに含まれる内容量の記載を 

改訂しました。 

⚫ 必要なものリストを見やすくしました。 

⚫ ラベル化 cRNA の NanoDrop による評価の記述を簡便化しました。 

⚫ QC レポートの解像度を改善しました。 

⚫ ハイブリエイドの使い方の絵を一部修正しました。 

⚫ オーブンの写真を型番 G2545A のものに変更しました。 

mailto:email_japan@agilent.com
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Ver.6.9 での更新点 

⚫ 保証期間の記述を変更しました。  

Ver.6.7 での更新点  

⚫ 実験上の注意点を追加しました。 

 

プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生する

ため、日本語プロトコルは英語の最新バージョンに比べて、遅れが生じます。製品ご購入の際は、必ず製品

添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新の英語版を 

参照ください。 
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2．実験に使用する Agilent キット 

 

■Low Input Quick Amp Labeling Kit, one-color 24 反応分 

（製品番号 5190-2305） （※本キットは、Cyanine 3-CTP を含みます） 

＜内訳＞ 

⚫ Cyanine 3-CTP （24 反応分チューブ×1 本） 

⚫ Low Input Quick Amp Labeling Kit 単品（製品番号 5190-2308 

この製品番号の商品は Cyanine 色素が含まれません。） 

 

Component  Volume 

T7 Promoter Primer 24 µL 

5xFirst Strand Buffer 100 µL 

0.1M DTT 70 µL 

10mM dNTP Mix 20 µL 

AffinityScript RNase Block Mix 36 µL 

5x Transcription Buffer 160 µL 

NTP mix 35 µL 

T7 RNA polymerase Blend 10 µL 

Nuclease Free Water 250 µL 

 

※ 本キットは、-20℃で保存してください。 

※ Cy3-CTPは開封前-20℃、融解後4℃で保存してください。実験間隔があく場合は-20℃でも保

存できます。 

※ Cy3-CTPのみの販売はしておりません。 

※ 本キットでは10ng~200ngのtotal RNAから、ラベル化反応をスタートすることができます。ただ

し、マイクロアレイのフォーマットにより推奨量が異なりますのでご注意ください(後述)。 

 

Low Input Quick Amp Labeling Kit, One-color （製品番号 5190-2305） は、アジレントマイクロ

アレイにあわせて最適化されています。他プロトコルで調製したラベル化サンプルをハイブリダイゼー

ションに用いた場合、問題の生じるケースがあります。その場合サポート対象外になることをご了承く

ださい。 

 

 

■アジレント RNA Spike-In キット (1 カラー用) 

（製品番号 5188-5282） 

One-Color Spike-Mix (10 uL) 

Dilution buffer  (1.2 mL) 

※全ての試薬は-80℃で保存してください。 
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■アジレント Gene Expression Hybridization Kit 

（製品番号 5188-5242） 

Component 

25x Fragmentation Buffer  (400-500 uL) 

2x GE Hybridization Buffer HI-RPM (1.25mL x 2 本) 

10 X Blocking Agent (凍結乾燥) 

※ 本キットは開封するまでは室温で保存してください。 

※ 10x Blocking Agent を調製した後は、この試薬のみ-20℃で保存してください。 

※ 本キットの使用可能アレイ数は下記のようになります。 

 1x244K, 1x1M 10 アレイ 

2x105K, 2x400K 20 アレイ 

4x44K, 4x180K 45 アレイ 

8x15K, 8x60K 100 アレイ 

 

※ 下記 2 つの試薬は個別に購入することが可能ですが、Gene Expression Hybridization  

kit (5188-5242)に含まれる試薬の 10 倍量となります。 

2 x Hi-RPM Hybridization Buffer (5190-0403) 

10 x Blocking Agent (5188-5281) 

 

■アジレント Gene Expression Wash Buffer 

Gene Expression 洗浄バッファ 1 4L （5188-5325） 

Gene Expression 洗浄バッファ 2 4L （5188-5326） 

 

■アジレント Gene Expression Wash Pack (製品番号 5188-5327) 

Gene Expression 洗浄バッファ 1 （5188-5325）が 2 個、Gene Expression 洗浄バッファ 2

（5188-5326）が 1 個および TritonX-102 (1.35mL のチューブ 6 本)のセットです。 

 

 

実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わせ 

頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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アジレント 遺伝子発現マイクロアレイ 

 

 

1 パック (1M、244K フォーマット) は、 

１枚のスライドグラスに１枚のアレイが載っています。 

 

 

 

1x1M フォーマット 1x244K フォーマット 

  

2 パック （2x400K、2x105K フォーマット） は、 

1 枚のスライドグラスに 2 枚のアレイが載っています。 

 

 

 

2x400K フォーマット 2x105K フォーマット 

 

4 パック (4x180K、4X44K フォーマット) は、 

1 枚のスライドグラスに 4 枚のアレイが載っています。 

 

 

 

4x180K フォーマット 4x44K フォーマット 

 

8 パック (8x60K、8X15K フォーマット) は、 

1 枚のスライドグラスに 8 枚のアレイが載っています。 

 

 

 

8x60K フォーマット 8x15K フォーマット 

 

 

必要なソフトウェア 

アレイフォーマット スキャナ スキャンコントロールソフト Feature Extraction 

8x15K, 4x44K, 

2x105K, 1x244K 

B スキャナ、C スキャ

ナ、または SureScan 

v7.0.1 以降 

（SureScan は v9.1） 

v9.5 以降 

8x60K, 4x180K, 

2x400K, 1x1M 

高解像度仕様のCスキ

ャナまたは SureScan 

v8.4.1 以降 

（SureScan は v9.1） 

v10 以降 

105 K105 K

15K

15K

15K

15K

15K

15K

15K

15K

44K44K44K44K

400 K 400 K 

180K 180K 180K 180K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 

60K 

244 K 1M 
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3. 実験に必要な消耗品など

アジレント遺伝子発現アレイ実験に必要な消耗品および器具のリスト（実験プロトコル v6.7 対応）  

（2019 年 12 月作成） 

対応マイクロアレイフォーマット：1x1M, 2x400K, 4x180K, 8x60K, 1x244K, 2x105K, 4x44K, 8x15K 

※指定： 必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 

※推奨： 安定した結果を得るために、推奨品の使用をお奨めします。推奨品以外の製品を使用された場合、サポート対象外になります。 

※相当： 備考欄に記載された条件を満たすものなら、他製品をご使用されてもかまいません。 

 

■消耗品 青文字は Agilent 製品です。  問い合わせ先：アジレント・テクノロジー株式会社 (電話 0120-477-111） 
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【マイクロアレイの保管について】 

開封前のマイクロアレイは、室温で保存をして下さい。マイクロアレイのフォイルの袋開封後は、マイクロア

レイのスライドは室温の暗所で、真空デシケータか窒素パージしたボックスで保管をしてください。開封後は

高湿・温度変化・外気との接触を極力避けて下さい。保管に必要な設備がない場合、全てのマイクロアレイ

スライドは受注製造によって１スライドパッケージで納品することが可能です。納期はお問い合わせください。 

 

【試薬・消耗品の保管について】 

Cyanine 3-CTP は、使用するまで-20℃以下での保存を推奨しています。一旦融解して使用を開始した後

は、凍結融解の繰り返しを避けるために、開封後は 4℃、遮光状態で保管してください。実験間隔があく場

合は、-20℃でも保存可能です。 

 

【試薬・消耗品の保証期間について】 

アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋あるい

はボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については欠品等があった

場合も交換ができない場合がありますので、製品が納品されたらすぐに内容物を確認して下さい。 
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4．実験に必要な機器・器具 

 

 青文字は Agilent 製品です 
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5. 実験を始める前に 

 

＜実験中の注意点＞ 

⚫ 実験室内では必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

⚫ スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

⚫ Cyanine 3-CTP は発癌性物質を含んでいます。吸引、誤飲、皮膚への直接の接触は避けてください。 

⚫ Cyanine 3-CTP は光で分解します。出来る限り光にあたらないように注意して使用してください。保

管時，反応時は必ず遮光してください。 

⚫ RNase のコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアーゼ

フリーの溶液およびピペットチップを使用してください。 

⚫ 本実験では、毒性のある試薬を使用します。操作時の安全には、十分ご注意ください。 

⚫ ハイブリダイゼーションバッファには塩化リチウム(LiCl)が含まれています。 

塩化リチウム(LiCl)には中枢神経系への毒性があります。催奇性があり、乳児に悪影響を与える可

能性があります。不妊を誘発する可能性があります。吸入、皮膚接触、誤飲により、害を引き起こしま

す。必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

⚫ ハイブリダイゼーションバッファにはラウリル硫酸リチウム(LLS)が含まれています。 

ラウリル硫酸リチウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。必

ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

⚫ ハイブリダイゼーションバッファには Triton が含まれています。誤飲により害を引き起こします。また、

目に入った場合深刻なダメージを与えます。 

⚫ Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。必ず、

適切なヒュームフード（ドラフト）内で使用して下さい。また、有機溶媒を含んでいますので、HPLC 廃

液およびフェノール廃液と同様な廃棄処理を行ってください。 

⚫ アセトニトリルは引火性と揮発性があります。吸引、皮膚接触、誤飲により肝臓、腎臓、循環器、中枢

神経系害を引き起こします。 

⚫ 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わ

せ頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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6.プロトコルの全体図 

 

 

 

 

 

 

 

total RNA 

RNAtotal 

RNA 
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ラベル化ステップのタイムテーブル 

 

Step Temperature  Time 

cDNA合成 155 min 

プライマーとテンプレートの熱変性 65ºC  10 min 

急冷 氷上 5 min 

二本鎖cDNA合成 40ºC 120 min 

逆転写酵素の失活 70ºC 15 min 

急冷 氷上  5 min 

cRNA合成 120 min 

cRNA合成 40ºC 120 min 

cRNA精製 30 min 

cRNA精製  RT  30 min 
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7．実験の操作手順 

 

１日目：実験の前準備 

 

⚫ 実験を始める前に、以下のものを準備してください。 

➢ マイクロピペッター（RNA 用） 1-10 uL,10-100 uL,100-1000 uL の３本 

➢ ピペットチップ（RNA 用） 上記各サイズ対応 

➢ チューブ立て 

➢ 1.5 mL チューブ（RNaseFree） 

➢ アイスボックス 

➢ Nuclease-free water 

➢ 96-100％ エタノール 

➢ タイマー 

➢ ボルテックスミキサー 

➢ パーソナル遠心機(スピンダウン用) 

➢ 油性ペン 

 

⚫ あらかじめ使用する機器の温度設定をしておきます。 

➢ ウォーターバスを 37℃または 40℃に設定。cRNA 増幅＆ラベル化反応後 60℃に設定 

➢ ヒートブロックを 65℃、80℃に設定。cDNA 合成後 70℃に設定 

 

⚫ 使用する試薬を解凍しておきます。 

➢ 酵素以外の試薬は、指定がない限り室温より高い熱をかけずにできるだけ早く溶かします。ボ

ルテックスミキサーで撹拌し、5~10 秒スピンダウンして液を底に集めます。 

➢ 酵素は軽くスピンダウンします。 

➢ 全ての試薬は使用直前まで氷上においておきます。 

※反応には、Cyanine 3-CTP (10 mM)を 1 反応あたり 0.24 uL 使用します。事前に反応数を確認

し、十分な Cyanine Dye が手元にあるようにします。 
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8. 実験：１日目 

（必ずプロトコルを参照ください。） 

 

8-1. One-Color Spike-Mix の調製（オプション） 

Spike-In kit に含まれる Spike-Mix を Dilution Buffer で希釈し、希釈物をスタート RNA に添加します。ラ

ベル化に用いるスタート RNA 量によって、Spike-Mix の希釈率が変わります。 

実験に使用する total RNA は、    ng です。下記の表を参照すると、今回の希釈手順は、それぞれ、以

下の通りになります。 

 

 

1. Spike-Mix(原液)をウォーターバスで 37℃、5 分間加温し溶かします、その後ボルテックスで混合し、スピ

ンダウンしてチューブの蓋、壁に付いた液を集めます。ラベル化反応を行う場合はウォーターバスを

40℃に変更します。 

2. 1st 希釈液を作ります : 2 uL の Spike-Mix に 38 uL の Dilution Buffer を加えます（1:20） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

3. 2nd 希釈液を作ります : 2 uL の 1st 希釈液に 48 uL の Dilution Buffer を加えます（1:25） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

4. 3rd 希釈液を作ります : 2 uL の 2nd 希釈液に___uL の Dilution Buffer を加えます（1:  ） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

5. 4th 希釈液を作ります : ___uL の 3rd 希釈液に___uL の Dilution Buffer を加えます（1:  ） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

 

最終希釈産物(3rd あるいは 4th 希釈液)の調製量は、1 回の実験の反応数により異なります。ピペットエラー

を考慮し、必要量よりも多めに調整してください。 

 

注意 Spike-in 量の精度を確保するため、希釈の際は 2 uL 以上の量を扱うようにしてください。 

注意 調製した 1st 希釈液は、‐70 ～ ‐80℃で約 2 ヶ月まで保存できます。さらに、8 回までの凍結

融解を繰り返すことが可能です。2nd 希釈液、3rd 希釈液および 4th 希釈液は凍結融解して再

使用することができないので、実験の都度調製してください。 

スタート RNA 量 希釈手順 3rd あるいは 4th Spike- Mix の 

必要量(uL)/反応 

total RNA (ng) PolyA+ RNA (ng) 1st 2nd 3rd 4th  

10 - 1:20 1:25 1:20 1:10 2 

25 - 1:20 1:25 1:20 1:4 2 

50 - 1:20 1:25 1:20 1:2 2 

100 - 1:20 1:25 1:20 - 2 

200 - 1:20 1:25 1:10 - 2 

- 5 1:20 1:25 1:20 - 2 
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8-2. total RNAからのラベル化 cRNA合成 

Low Input Quick Amp Labeling Kit は、10 ng から 200 ng の範囲の total RNA または、5 ng 以上の poly 

A+ RNA からラベル化 cRNA を合成することができます。 

ただし 

・十分量のラベル化 cRNA を得るためには、4 パック(4x44K、4x180K)および 8 パック(8x15K、8x60K)の

場合は 25ng 以上、1 パック(1x244K、1x1M)および 2 パック(2x105K、2x400K)の場合は 50ng 以上の

total RNA を用いることをお勧めします。 

・得られる total RNA 量が少ない場合は、8 パック使用時のみ 10ng までスタート total RNA 量を下げること

ができます。 

・スタート量の異なる同じサンプルのアレイデータを比較すると、スタート量が多い方が検出できるプローブ

数は多くなります。total RNA 量が十分にある場合は、上記下限量ではなく 100 ng 弱～200 ng の total 

RNA を用いることをお勧めいたします。 

・RNA 量は一連の実験系では揃えることをお勧めします。 

⚫ 反応チューブにサンプル名を書いてください。 

⚫ 1 反応あたりに使用する試薬量は 1 uL 以下になるので、必ずマスターミックスを調製後、各チューブ

に分注してください。 

⚫ 各マスターミックスは、4 反応の場合は 5 反応分、8 反応の場合は 10 反応分を調製してください。 

 

1. 1.5 mL のチューブに、10 ng から 200 ng の total RNA を最終量が 1.5 uL になるよう加えます。濃度が

濃い場合は希釈してください。 

注意 チューブへの吸着を防ぐために、total RNA は 100 ng/uL 以上で保存してください。 

100 ng/uL 以下にする場合は、使用直前に調製しすぐ使用してください。 

2. 各チューブに希釈した 3rd あるいは 4th Spike-Mix を 2 uL 加え、ピペッティングあるいはタッピングで良

く混合後、スピンダウンします。合計 3.5 uL となります。 

注意 total RNA および希釈した Spike-Mix の混合物は 3.5 uL を超えないようにしてください。 

3. 下記表に従い T7 Promoter Primer Mix を調製します。ピペッティングで混合し、スピンダウンします。 

 

注意 ここで使用する水は、必ずラベル化キットに含まれている Nuclease-free water か、Invitrogen

社の DNase/RNase-free water (10977015)をお使いください。DEPC 処理水を使用した場合、

この後の反応を阻害する恐れがあります。 

 

4. 各チューブに T7 Promoter Primer Mix を 1.8 uL ずつ加え、ピペッティングあるいはタッピングで良く混

合後、スピンダウンします。合計 5.3 uL になります。 

5. 65℃で 10 分インキュベーションします（熱変性）。 

 1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)
 T7 Promoter Primer(緑キャップ) 0.8 4 8
 Nuclease-free water(白キャップ) 1 5 10
 トータル量 1.8 9 18
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6. 氷で急冷、そのまま 5 分間冷却します。 

7. 5X First Strand Buffer は事前に 80℃のウォーターバスで 3－4 分間温めます。ヒートブロックを使用す

る場合はヒートブロックの well に Nuclease Free Water を適量入れ、確実にチューブの底に熱が伝わる

ようにします。ボルテックスでよく混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。使用

するまで室温で置いておきます（氷上に置くと、析出する場合があります）。使用直前に再度析出物がな

いか確認してください。ロットによって析出し易い場合があります。室温にもどすとすぐ析出する場合は、

以下の手順で溶解してください。 

a. 5xFirst Strand Buffer を 80℃のウォータバスで 5 分間加熱し、10 秒以上ボルテックスにかけスピ

ンダウンします。5 分間室温におきます。 

b. 5 分後、析出物が確認されない場合は、速やかにマスターミックスを調製します。 

c. 5 分以内に析出物が確認された場合は再び 80℃のウォータバスで 4 分ほど加熱し、10 秒間ボ

ルテックスしてスピンダウンします。 

d. 室温におき、5 分以内にマスターミックスを調製します。 

8. 下記表に従い cDNA マスターミックスを室温で調製します。ピペッティングで混合し、スピンダウンします。 

注意 AffynityScript RNase Block mix は酵素の混合物です。使用直前まで氷上に置いておきます。

AffynityScript RNase Block mixを添加後もマスターミックスは氷上ではなく室温に置き、

添加後すぐに使用してください。 

Note  65℃10分のインキュベーション中に5xFirst Strand Buffer、01.M DTTおよび10 mM dNTP

を混合し、5 分間の冷却中に AffynityScript RNase Block mixを添加・混合しマスターミッ

クスを調製するとすぐに次のステップに進むことができます。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
  5xFirst Strand Buffer(緑キャップ) 2 10 20
　0.1M DTT(白キャップ) 1 5 10
　10mM dNTP mix(緑キャップ) 0.5 2.5 5
　AffinityScript RNase Block Mix
(紫キャップ)

1.2 6 12

　トータル量 4.7 23.5 47  

9. 氷上で冷やしていた各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 

 

10. cDNA マスターミックス 4.7uL を各チューブに加え、ピペッティングで良く混合し、

スピンダウンします。総量は 10uL になります。 

 

 

11. 40℃のウォーターバスで 2 時間インキュベーションします。 

12. 軽くスピンダウンした後、70℃で 15 分間インキュベーションし、酵素を失活させます。 

13. サンプルチューブを氷上に移し、5 分間冷却します。 

 

4.7uL

cDNA合成反応
マスターミックス
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14. 各チューブをスピンダウンし、チューブ蓋などについた水滴を落とします。 

Note ただちに実験を進めない場合、サンプルを-80℃で保存することができます。 

15. 下記表の上から順に加え、Transcription Master Mix を室温で調製します。ピペッティングで混合し、ス

ピンダウンします。 

注意 T7 RNA Polymerase Blendは酵素の混合物です。使用直前まで氷上に置きおきます。T7 

RNA Polymerase Blend を添加後もマスターミックスは氷上ではなく室温に置き、添加

後すぐに使用してください。 

Note 70℃15分のインキュベーション中に Nuclease-free water、5xTranscription Buffer、0.1M 

DTT および NTP mix を混合し、5 分間の冷却中に T7 RNA Polymerase Blend および

Cyanine3-CTPを添加・混合するとすぐに次のステップへ進むことができます。 

1反応分の必要量(uL) 5反応分(uL) 10反応分(uL)  
  Nuclease-free water(白キャップ) 0.75 3.75 7.5
　5xTranscription Buffer(青キャップ) 3.2 16 32
　0.1M DTT(白キャップ) 0.6 3 6
　NTP mix(青キャップ) 1 5 10

　T7 RNA Polymerase Blend
(赤キャップ)

0.21 1.05 2.1

　Cyanine3-CTP 0.24 1.2 2.4
　トータル量 6 30 60  

 

 

16．各チューブに Transcription Master Mix を 6uL 加え、ピペッティングで穏やかに

混ぜた後、スピンダウンします。総量は 16uL になります。 

 

 

17. 40℃のウォータバスで 2 時間インキュベーションします。 

注意 ウォーターバスあるいはヒートブロックにアルミをかぶせ、遮光してください。ヒート

ブロックを使用する際、ヒートブロックのウェル形状とチューブが合わない場合は、 

ウェルに水を少し入れてチューブ全体へ熱が均一に伝わるようにしてください。 

 

18. ハイブリダイゼーションを引き続き当日中に行う場合には、インキュベーション終了後、以下の設定をし

ておきます。 

⚫ ウォーターバスを60℃に設定 

⚫ ハイブリダイゼーションオーブンを65℃に設定(ローターを取り付けておきます)。 

オーブン庫内が表示温度で安定するまでに1時間~1時間半かかります。  

6.0uL

Transcription
Master Mix



遺伝子発現マイクロアレイ 1 色法プロトコル 20 

8-3. Cyanine3-ラベル化 cRNA の精製 

Qiagen RNeasy Mini KitあるいはStratagene(Agilent) Absolutely RNA Nanoprep Kitを使ってラベル

化cRNAを精製します。この精製ステップにより、ラベル化の際に取り込まれなかったラベル化ヌクレオチド

（モノマー）を除去することができます。モノマーが、ハイブリダイゼーション液中に存在すると、マイクロアレ

イのバックグランドの蛍光が著しく高くなります。 

 

⚫ ラベル化cRNAの精製には、Qiagen RNeasy Mini Kitの使用を推奨します。 

⚫ Stratagene Absolutely RNA Nanoprep KitはQiagen RNeasy Mini Kitに比べて溶出量が少ないの

で、ラベル化cRNAをより高濃度で精製することができます。少量サンプルからラベル化をスタートした

場合は、Stratagene Absolutely RNA Nanoprep Kitをお勧めします。 

⚫ データの相互比較が必要なプロジェクト内では、精製キットはどちらかに統一することをお勧めします。 

 

【Qiagen RNeasy Mini Kitを用いて精製する場合】 

以下に記載してある手順に従って実験を進めてください(Qiagenのプロトコルを一部変更しています)。 

• 使用前に、RPEバッファにエタノール(96-100%)を必要量加えてください。RPEバッファは次のページの

洗浄ステップで使用します。調製が終わりましたら、フタのラベルのethanolの項目にチェックマークを付

けてください。 

• 全ての遠心のステップは、13,000rpm(10,000g)以上の回転数で行ってください。 

• 遠心を4℃で行うことにより、cRNAの収率があがることが確認されております。以下の遠心ステップを

4℃で行うことを強くお奨めします。 

• RLTバッファにβ-メルカプトエタノール(β-ME)を加える必要はありません（β-MEが入っていても問題あり

ません）。 

 

1. 84 uLのNuclease-free waterをcRNAサンプルに加え混合し、液量を100 uLにします。 

 

 

2. 350 uLのRLTバッファを加え、混合します。 

3. 250 uLのエタノール(純度96-100%)を加え、ピペッティングで静かに混合します。スピンダウン 

を含め遠心はしないでください。 

  



 

遺伝子発現マイクロアレイ 1 色法プロトコル 21 

4. 700 uLのcRNAサンプルを2 mLのコレクションチューブをつけたRNeasy miniカラムに移します。カラム

チューブを13,000 rpmで30秒間遠心します。カラムを素通りした液は捨てます。 

 

 

 

 

 

 

 

 

 

5. RNeasyカラムを新しいコレクションチューブに移し、500 uLの調製済みのRPEバッファ(エタノールを加

えたもの)をカラムに加えます。カラムチューブを13,000 rpmで30秒間遠心します。カラムを素通りした液

は捨てます。 

 

 

 

 

 

 

 

 

6. コレクションチューブはそのまま使用し、再度500 uLのRPEバッファをカラムに加えます。カラムチューブ

を13,000 rpmで1分間遠心します。カラムを素通りした液は捨てます。カラムを新しい2 mlコレクションチ

ューブに移し、13,000 rpmで30秒間遠心し、残っているRPEバッファを完全に取り除きます 

 

7 RNeasyカラムを新しい1.5 mLチューブに移します。 

 

8. 30 uLのNuclease-free waterをカラムのフィルター中央に加え、1分間おきます。カラムチューブを

13,000 rpmで30秒間遠心します。カラムを通った液はそのまま残します(液を捨てないように注意してく

ださい)。 

 

9. チューブは氷上においておきます。使用済みのカラムは捨てます。回収したcRNAの濃度、収量および

品質をUV測定とバイオアナライザを用いて確認します。 
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【Stratagene Absolutely RNA Nanoprep kitを用いて精製する場合】 

事前準備 

1．80%スルフォランの調製 

 a.100%スルフォランを溶けるまで37℃で温めます。100%スルフォランは室温で固体です

が、80%スルフォランは室温で液体のまま、最低1ヶ月は保存できます。 

 b.1 mLのRNase-free水を4 mLの100%スルフォランに添加し、5 mLの80%スルフォランを調

製します。5 mLの80%スルフォランで50回精製できます。 

2．1 x high-salt wash bufferの調製 

 a.16 mLの100%エタノールを1.67 x High-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保存

します。 

3．1 x low-salt wash bufferの調製 

 a.68 mLの100%エタノールを5 x Low-Salt Wash Bufferに添加します。 

 b.ふたを閉め、よく振って混合します。ふたの1x(Ethanol Added)にチェックを入れます。室温で保存

します。 

 

精製操作 

遠心は4℃で行ってください。 

1. 100 uLのLysis BufferをcRNAサンプルに加え、116 uLにします。ピペッティングでよく混合し、スピ

ンダウンします。 

2. 等量（116 uL）の80%スルフォランを加え、cRNAサンプルと混ざるまでボルテックスで混合

し、スピンダウンします。 

3. RNA-binding nano-spin cupを2mLのコレクションチューブに入れます。 

4. 80%スルフォランとcRNAサンプルの混合物をRNA-binding nano-spin cupに全量移し、

RNA-binding nano-spin cupにキット付属のキャップをはめます。 

5. 12,000 g以上で、60秒遠心します。 

6. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度

遠心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-

binding nano-spin cupをコレクションチューブに戻します。 

7. 300uLのHigh-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000 g以上で60秒遠心します。 

8. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度

遠心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-

binding nano-spin cupをコレクションチューブに戻します。 

9. 300uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000 g以上で60秒遠心します. 

10. ステップ8およびステップ9をもう一度繰り返します。 

11. 遠心後、溶液がRNA-binding nano-spin cupに残っている場合は、素通りした液を捨て再度

遠心してください。溶液が残っていない場合は、カラムを素通りした液は捨て、RNA-

binding nano-spin cupをコレクションチューブに戻します。  
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12. 300 uLのLow-Salt Wash BufferをRNA-binding nano-spin cupに加え、キャップをはめ、

12,000 g以上で3分遠心します。 

13. RNA-binding nano-spin cupを新しい2 mLのコレクションチューブに移します。 

14. 20 uLのElution BufferをRNA-binding nano-spin cupに加えます。キャップをはめ、室温で2

分間静置します。60℃に温めたElution Bufferを用いると収量が上がります。 

15. 12,000 g以上で5分遠心します。 

16. 収量を上げたい場合、ステップ14およびステップ15を繰り返します。ただし、ハイブリダ

イズに必要な濃度を下回る可能性があります。 

17. 溶出された液をふた付きのチューブに移します。チューブは氷上におき、回収したcRNAの

濃度、収量及び品質をUV測定とバイオアナライザを用いて確認します。 
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8-4. ラベル化 cRNA の分析 

【NanoDropによる評価】 

ラベル化cRNAの収量は、total RNAの純度や質(分解度)によっても異なります。合成したcRNA量は、 

キュベットを使った分光光度計で測定するには少なすぎる場合がほとんどです。濃度決定に使用するRNA

量を最小限に抑えるために、本プロトコルではNanoDrop分光光度計を推奨しています。 

⚫ NanoDrop のソフトウェアを起動し、”Microarray Measurement”のタブを選択します。 

Sample Type は RNA-40 と選択します。 

⚫ 1 uL の Nuclease-free water で、ブランクを設定します。 

⚫ 1 uLのラベル化(増幅)cRNAを測定し、A260とA550を記録します。 

 

（1） NanoDrop 計測結果より、cRNA濃度 （ng/uL）を記録します。 

 RNA濃度が自動算出されない分光光度計をご使用の場合、A260の値から以下の式で算出して下さい。 

cRNA conc. (ng/uL) * = A260 x 40 ug/mL x dilution factor** 

 *光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

 **希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

（2） (1) のcRNA濃度（ng/uL）に溶出量（ 使用した精製キットにより30 ul あるいは20 ul ） 

を乗じ、以下の式でcRNA収量を算出します。 

cRNA yield(ug) = cRNA conc(ng/uL) × 30(uL) / 1000  

 

 

（3） NanoDrop 計測結果より、Cy3色素の濃度 (pmol/ul)を記録します。 

色素濃度が自動算出されない分光光度計をご使用の場合、A550の値から以下の式で算出して下さい。 

Cy3-CTP conc (pmol/ul) * = A550 x 1000 ÷ 150 mM-1cm-1 x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

（4） 以下の式で、Cy3色素の取込率を算出します。 

 

 

 

  

Cy3-CTP incorporation ( pmol/ug) =
Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)
Cy3-CTP incorporation ( pmol/ug) =

Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)

Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)
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cRNAの収量およびCy3-CTPの取り込み率が下記基準を満たしているか確認します。基準を満たさない場

合には、再度cRNAの調製をされる事をお勧めいたします。ただしスタートtotal RNA量によっては十分量得

られない場合があります。 

また測定した濃度から、マイクロアレイへのハイブリダイゼーションに必要な cRNA 量を計算します。 

アレイフォーマットによって必要量が異なるのでご注意ください。 

マイクロアレイフォーマット 収量（ug) Cy3-CTP 取り込み率 (pmol/ug) 

1 パック (1x244K, 1x1M) 5 6 

2 パック (2x105K, 2x400K) 3.75 6 

4 パック (4x44K, 4x180K) 1.65 6 

8 パック (8x15K, 8x60K) 0.825 6 

 

【バイオアナライザによる評価】 

⚫ 1.5 mL エッペンチューブに 1.5 uL のラベル化 cRNA を移します。熱変性（70℃ 2 分）を行い、氷上に置

きます。1 uL をバイオアナライザの測定に使用します。 

⚫ バイオアナライザでラベル化 cRNA を泳動する際は、mRNA assay を選択します。 

バイオアナライザのエレクトロフェログラムから cRNA の品質を確認します。 

バイオアナライザの分析例 

 

ラベル化サンプルのシグナルの大部分が、200 から 2000 塩基長のサイズ範囲に位置しているかを確認し

て下さい。これ以外の領域にピークの大部分がある場合、正確なデータが出ない可能性があります。データ

データ分析時に、ツールバーのアイコン をクリックすると、横軸の表示を秒あるいは nt に切り替えら

れます。 

 

ラベル化 cRNA の保存 

cRNA をすぐに使用しない場合には、少量に分注し、暗所-80℃で保存します。長期保存の場合は、チュー

ブに 1 回分の分量を分注して保存して下さい。 

サンプルの冷凍、解凍のサイクルを繰り返すと cRNA が分解しやすくなります。保管している cRNA の品質

がわからない時は、バイオアナライザおよび UV 計で再度品質を確認することをお勧めします。 

  



遺伝子発現マイクロアレイ 1 色法プロトコル 26 

8-5．ハイブリダイゼーションの準備 

⚫ 増幅反応を行っている間に、次のものを準備してください。 

マイクロアレイやガスケットスライド、試薬の Expire date を確認してください。古いものを使用するとノイ

ズが上がる等トラブルが発生する可能性があります。 

➢ アジレント 遺伝子発現マイクロアレイ  

➢ 遺伝子発現ハイブリダイゼーションキット 

➢ ハイブリダイゼーションチャンバ 

➢ ガスケットスライド 

➢ ピンセット（清潔なもの） 

➢ パウダーフリー手袋  

➢ マイクロピペッター（RNA 用）1-10uL,10-100uL,100-1000uL およびピペットチップ（RNA 用） 

➢ 1.5 mL チューブ（RNase Free） 

➢ チューブ立て（RNA 用） 

➢ 高速遠心機 

➢ ボルテックスミキサー 

➢ アイスボックス 

➢ タイマー 

➢ ウォーターバス（60℃） 

➢ ハイブリダイゼーションオーブン（65℃） 

⚫ 使用する機器の温度設定を確認しておきます。 

➢ ウォーターバスを 60℃に設定 （増幅反応終了後に変更します。） 

➢ ハイブリダイゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 

庫内が表示温度で安定するまでに1時間~1時間半かかります。早めに設定をしておいて下さい。 

 

≪ハイブリダイゼーションオーブン温度の校正法≫ 

ハイブリダイゼーションの温度はマイクロアレイのシグナル強度やノイズレベルに大きな影響を及ぼ

します。表示温度と実測値が一致するか 3 ヶ月に 1 度は確認し、0.2 ℃以上異なる場合は下記手順

で校正してください。 

1. オーブンのローターと、使用するスライド数とバランスをあわせてチャンバをセットします。 

2. 温度を 65℃、回転数を 10 にセットし、温度が安定するまで 3 時間ほど待ちます。 

3. 校正済みの温度計をセットします。 温度センサー部位をとりつけます。この時センサー部位が

オーブンの壁につかないように、空間の温度をはかるようにして下さい。 

4. 3 時間程度、温度計の温度が安定するまで待ちます。 

5. 実測温度と設定温度を比較し、0.2 ℃以上異なるようであれば、次の手順で合わせます。 

6. オーブンの ▲ ボタンと ▼ボタンを同時に押し、温度表示が点滅するまで待ちます。あるいは 

▲ ボタンと ▼ボタンを同時に長押し、温度両側の「.」が点滅するまで待ちます。 

7. 点滅しているうちに、▲ボタンと▼ボタンで、表示温度を温度計が示す温度にあわせます。 

8. その後再度表示を 65℃にあわせ 3 時間ほど待ち、表示温度が実測値と合うか確認します。 

詳細は弊社サポートサイトの「Agilent G2545A ハイブリダイゼーションオーブン校正方法」をご覧く

ださい。  
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8-6. ハイブリダイゼーション 

 

8-6-1. 10x Blocking Agent の準備 

1. スピンダウンしてペレットをチューブの底に集めます。 

2. Nuclease-Free Water を 0.5ml, Blocking Agent に加えます。 

※ 単品で購入した大容量の Blocking Agent （5188-5281）をお使いの場合は、Nuclease Free 

Water 1.25 ml で溶解して下さい。 

3. 穏やかにボルテックスをして溶解します。溶解しない場合は 37℃で 4, 5 分温めます。 

4. 5～10 秒スピンダウンし、チューブの蓋や壁についた液を集めます。 

5. 調製した 10x Blocking Agent は-20℃で 2 か月間、保存できます。凍結融解が 5 回以内になるように

分注して保存してください。融解後は上記ステップ 3, 4 を行って下さい。 

 

8-6-2. マイクロアレイの取り扱い上の注意 

■マイクロアレイのプローブは、アレイスライドのラベルに”Agilent”の文字が入っている面(アクティブ面)に

載っています。 マイクロアレイスライドに貼ってあるラベルに”Agilent”の文字が入っている方が

Active サイド(プローブが搭載されている側)、数字のみが記載されたバーコードラベルが付いている面

は Inactive サイドになります。ハイブリダイゼーションを行う

際は、アレイがプリントされている Active サイドに、必ずハイ

ブリ溶液が接するように注意してください。 

 

■スライドグラスを取り扱う際はパウダーフリーの手袋をはめ、スライドグラスの縁を注意深く持って取り扱

って下さい。スライド表面には両側とも決して触らないで下さい。 

 

■ハイブリダイゼーション開始後は洗浄終了まで、アレイを乾燥させないように注意して下さい。 

 

■ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周りは

なるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

 

■ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内蔵の

水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

 

■手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを用い

てアレイスライドを乗せることが出来ます。 

 ※ハイブリエイドはハイブリダイゼーション作業を補助する 

オプションの器具です。
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8-6-3. ハイブリダイゼーションサンプルの準備 

 

1．下表に従い、Cy3 ラベル化 cRNA、10x Blocking Agent、Nuclease-free water、25x Fragmentation  

Buffer を 1.5 mL エッペンチューブに加え、緩やかにボルテックスをしてサンプルを十分に攪拌してくださ

い。複数のサンプルチューブがある場合は、全てのチューブにラベル化 cRNA、10x Blocking Agent お

よび Nuclease-free water を調製し、最後に Fragmentation Buffer を各チューブに添加してください。 

1 パックおよび 2 パック使用時に十分量の cRNA がない場合は、1.65 ug まで下げることができます。た

だし比較したいサンプル同士は同じ量をハイブリダイズに用いてください。 

 

 

 

2. 60℃のウォーターバスで30分インキュベーションします。必ず遮光してください。 

断片化(インキュベーション)が30分を超えない事が重要です。 

3. 30分後、ただちにサンプルを氷水上に移し、1分間冷却します。その後スピンダウンし速やかに、断片化

をストップさせるため、下表に従って速やかに2x GE Hybridization Buffer HI-RPMを加えます。各チュ

ーブはバッファを加えるまで氷上においておきます。 

注意 以前販売していた2x GE Hybridization Bufferと2x GE Hybridization Buffer HI-RPMは別

の試薬です。必ず2x GE Hybridization Buffer HI-RPMをご使用下さい。 

 

 

4． ピペットでゆっくりと液を混合させます。泡を立てないように十分に気をつけてください。泡が発生します

ので、ボルテックスは使用しないようにしてください。 

5．高速遠心機でスピンダウンして(13,000 rpm、1分、室温)、蓋や壁についた液を底に集めます。 

6．サンプルを氷上に置き、直ちにハイブリダイゼーションに使用してください。保存はできません。   

アレイフォーマット 8 パック 4 パック 2 パック 1 パック 

Cyanine3-labeled cRNA 600 ng 1.65 ug 3.75 ug 5.00 ug 

10xBlocking Agent 5 uL 11 uL 25 uL 50 uL 

Nuclease-free water 適量 適量 適量 適量 

25xFragmentation 1 uL 2.2 uL 5 uL 10 uL 

トータル量 (マイクロアレイあたり) 25 uL 55 uL 125 uL 250 uL 

Hybridization mix 

アレイフォーマット 8 パック 4 パック 2 パック 1 パック 

Fragmentation mix 25 uL 55 uL 125 uL 250 uL 

2xGE Hybridization Buffer HI-RPM 25 uL 55 uL 125 uL 250 uL 

トータル量 (マイクロアレイあたり) 50 uL 110 uL 250 uL 500 uL 

Fragmentation mix 
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8-7. ハイブリダイゼーションチャンバの組み立て 

 

ハイブリダイゼーションチャンバを組み立てるにあたり、以下が必要になります。 

 

■ハイブリダイゼーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ガスケットスライド： 

1 パック用 (G2534-60003), 2 パック用 (G2534-60002), 4 パック用(G2534-60011), 

8 パック用 (G2534-60014) 

                                                

 

 

 

 

 

 

 

 

 

■（オプション）ハイブリエイド 

  

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット

ガスケットスライド 
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1. ピンセットを使ってガスケットスライドのプラスチックカバーの端をつまみ、ゆっくりとはがします。ガスケッ

トスライドをパッケージから取り出します。この時、スライドの縁以外には触れないようにしてください。必

ずパウダーフリーの手袋を着用してください。 

 

 

 

 

 

2. チャンバベースの上に、ガスケットスライドを “Agilent”の文字あるいはバーコード番号が書かれている

面を上にして載せます。ガスケットスライドは、ハイブリダイゼーション溶液を介して直接アレイに触れま

すので、ほこり等がつかないようにすばやくセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

3. ガスケットスライドがしっかりとチャンバベースにセットされているか確認し、正しくされていない場合は、

再度セットし直してください。 

 

 

 

 

 

4.ハイブリダイゼーション溶液をガスケットスライド上にアプライします。アレイスライドのバーコード番号およ

びアプライしたサンプル位置を記録しておきます。 

アレイフォーマット
8pack
4pack
2pack
1pack

アプライする量(1アレイあたり)
40 uL
100 uL
240 uL
490 uL

調製した量(1アレイあたり)
50 uL
110 uL
250 uL
500 uL  

5. ハイブリダイゼーション溶液がガスケットのふちまで広がらないように、ガスケットの中央部分にアプライ

してください。スライドグラス上の全てのウェル間で、液面の高さが揃うように、ゆっくりと均等に液を配置

します。 

 

サンプルをアプライしないウェルがある場合、空白ウェルには水で

1x の濃度に希釈をした GE Hybridization Buffer HI-RPM を、 

アレイのフォーマットに応じて、上の表の量アプライして下さい。 

（オプションのハイブリエイド用いる場合、ここで次ページの【参考手

法】を参照下さい） 
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6. アレイ面(Agilent と書かれているバーコード面) を下にして(数字が書かれている方のバーコード面は上

に)、マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せます。このと

き、アレイスライドの縁またはバーコードシール部分を持つようにしてください。マイクロアレイスライドを

水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。ハイ

ブリダイゼーション溶液が漏れる原因になります。 

 

注意 2 枚のスライドのバーコードが、正しい位置で重なり合うようにセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

注意 1 スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、“ハ

イブリ溶液が接しているアレイ”と“接していないアレイ”があるように見える場合がありま

すが、問題ありません。アレイスライドを乗せた後は、位置の微調整などは行わず、すぐ

チャンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルを 

アプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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7. チャンバカバーを、チャンバベースの上にセットします。カバーの向きを間違えないように注意してくださ

い。 

 

8. クランプアッセンブリを、チャンバベースの丸くなっているコーナー側から差し込み、完全にストップする位

置まで移動させます。ストップする位置は、ちょうどチャンバの中央部になります。 

 

 

 

 

 

 

チャンバが水平に保たれていることをご確認した後、手でスクリューをしっかり締めます。チャンバにダ

メージを与える可能性があるので、ペンチなどの道具は決して使用しないでください。 

 

 

 

 

 

 

9. 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケットの

全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。ハ

イブリ溶液が行き渡っていない部分や、固定している泡により、ハイブリむらが起きる場合があります

ので、泡が動かない場合には、チャンバを手にもって振ることで、泡を移動させます。 

 

10. 残りのスライドも同様に、上記の作業を行ってください。 
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11. チャンバの組み立てが終わりましたら、予め 65℃にセットしたオーブンのローターに差し込みます。ハイ

ブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固定してください。 

複数のスライドグラスをハイブリダイズするときは、必ずローターのバランスをとってチャンバをセットす

るようにしてください。奇数枚の時は、スライドグラスなしでチャンバを組み立て、ローターの対面にセッ

トしてください。 

 

 

 

 

 

 

 

 

 

 

 

 

組み立てたチャンバは、下図 a のようにチャンバのねじが横向きになるように差し込みます（左右どち

らでも構いません）。下図 b のようにねじが正面あるいは背面に向いた状態では、ハイブリダイゼーショ

ンが不均一となります。 

a.                                         b. 

 

12. ハイブリダイゼーションオーブンの扉を閉め、回転数 10 rpm に設定します。 

 

13. 65℃で 17 時間ハイブリダイゼーションさせます。 

YES! NO! 

Agilent ハイブリダイゼーション 

オーブン (G2545A) 

ハイブリダイゼーション オーブンロータ 

(G2530-60029) 
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8-8. 洗浄の準備 

 

1.Triton X-102 の Gene Expression Wash Buffer への添加 

 

Wash Buffer の Expire date を確認してください。古い Buffer を使用するとノイズが上がる等トラブル

が発生する可能性があります。Expire Date が不明の場合は、Expire Date を調べますのでロット番号

を弊社にお知らせください。 

 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加すること

で、マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

 

10% TritonX-102 は Gene Expression Wash Pack (5188-5327)に含まれています。単体でもご購入

いただけます(50 mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10%Triton X-102 を加えます。 

この操作は、Wash Buffer１と 2 両方行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

2）.ピペットで 2 mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

5).Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済みのより

少ない量の Buffer にも添加することができます。 

 

2. Wash2 の保温 

洗浄前日から、Gene Expression Wash Buffer 2 とスライドグラス洗浄用ガラス容器(1 個)を 37℃

で保温しておきます。Wash Buffer 2 は白い箱ごと加温することをおすすめします。37℃のインキュベ

ータに入らない場合は、必要量の Wash Buffer 2 を蒸発を防ぐため必ず密閉容器に入れて温めて下

さい。 

インキュベータの表示温度と実測値が一致するか定期的にご確認ください。 
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9. 実験：２日目  スライドグラス洗浄の前準備 

⚫ 洗浄を始める前に、以下の機器・器具を準備してください。 

➢ スライドグラス洗浄用ガラス容器（中 3） 

➢ スライドラック(サーモエレクトロン 109) 

➢ スターラー（2） 

➢ 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2）  

※回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

➢ タイマー 

➢ ピンセット 

➢ パウダーフリーの手袋 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事前

に、確実に手袋から微粒子が発生しないことをご確認ください。ビーカーに入れた洗浄バッファ 

1 で手袋を事前に洗い、手袋から垂れる洗浄バッファが白濁していないこと、および手袋をあら

った後の、ビーカー内の洗浄バッファに微粒子がないことを確認してください。手袋から発生す

る微粒子は、アレイの表面に吸着して結果に大きな影響を及ぼします。なるべく手袋を洗浄バッ

ファに浸さないで操作することをお勧めします。 

 

スライドグラスの洗浄操作 

洗浄条件 

 

1. オゾンフリーブースを使用している場合はスイッチを入れます。Cyanine 3 もオゾン濃度によってはデ

ータに影響が出ることがあります。スキャンが終わるまでスイッチは切らないでください。 

注意 性能を保つため、オゾンフリーブースのチャコールフィルターは年に一回は交換してください。 

2. 以下の洗浄バッファを用意します。 

A ： 洗浄バッファ 1: Agilent Gene Expression Wash Buffer 1 

B ： 洗浄バッファ 2: Agilent Gene Expression Wash Buffer 2 (37℃で保温してあるもの) 

 

洗浄バッファの Expire date を確認してください。古い洗浄バッファを使用するとノイズが上がる等トラブ

ルが発生する可能性があります。 

37℃のウォーターバスまたはオーブンで洗浄バッファ 2 を加温します。洗浄直前時まで 37℃で保温して

下さい。弊社では、37℃で保温可能なスターラー付恒温槽（アズワン株式会社（1-5088-01、P36 の写

真参照）あるいは株式会社日伸理化 (SW-500NT）の利用を推奨しております。  

ガラス容器 洗浄バッファ 温度 用途  洗浄時間 

1 1 RT ガスケットスライドと 

アレイスライドの分離 

2 1 RT 洗浄 1min 

3 2 37℃ 洗浄 1min 
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3.  下記の通り、3 つの洗浄用ガラス容器を準備します。それぞれのガラス容器は回転子やラックを入れ

た状態で各洗浄バッファで共洗いをしてください。 

 

注意 ハイブリダイゼーションチャンバの分解を始める前に、全ての必要な洗浄バッファとガラス容器の

準備を行って下さい。洗浄・乾燥のステップは、できるだけ効率的に行って下さい。 

注意 注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間を守るこ

とは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果がばらついてしま

う場合があります。また、スライド洗浄を行う際の攪拌には、シェーカーを使わずに、必ずマグネッ

トスターラーを使用して下さい。 

 

ガラス容器 1 : 洗浄バッファ 1,  ガスケットの解体用 

ガラス容器 2 : 洗浄バッファ 1,  スライドラックと回転子を中に入れておきます。 

ガラス容器 3 : 洗浄バッファ 2 (37℃に保温したもの), 回転子を中に入れておきます。 

 

スターラー付恒温槽がある場合には、37℃に設定して、ガラス容器 3 をセットします（写真参照）。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ１の洗浄を開始するまで、37℃で保温し

てある洗浄バッファ２を加えないで下さい。 

 

 

 

 

 

 

 

  

 

スターラー付恒温槽 
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4. ハイブリオーブンからチャンバを取り出します。複数のスライドをハイブリダイゼーションしている場合も、

チャンバは必ず１つずつ取り出すようにしてください。泡が形成されているか、また泡が自由に動いてい

るか確認してください。 

 

注意 チャンバをオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイブリ液の覆ってい

る部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取り出した

チャンバは、必ずすぐに解体し、アレイスライドを洗浄バッファ 1 中のスライドラックに移すことが

重要です。また複数枚のスライドを一度に洗浄する場合、1 スライドずつ取り出し、解体の直前

まで、規定の温度に保温されていることが重要です。 

 

 

 

5. チャンバの分解 

a. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

b. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

c. 手袋をはめた手で、チャンバベースから重なっている 2 枚のスライドを同時に取り出します。この時

スライドの両端をしっかり持つようにしてください。すぐに、アレイスライドを上にし (数字が書かれて

いるバーコード面を上にして)、2 枚のスライドが重なっている状態でガラス容器 1 内の洗浄バッファ

1 にいれます。この時なるべく手袋が洗浄バッファ 1 に浸からないようにしてください。 

  

0 min 5 min

15 min 30 min

室温放置の影響を検証したデータ 
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6. 2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライド

を離します。フラットピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗浄することがで

きます。フラットピンセットがない場合は、参考手法の手順に従ってください。 

使用器具： フラットピンセット 33A (品番は p.9 参照)  

注意 丸い部分の半分以上でガラス面を持たないよう注意が必要。 

 

①  2 枚のスライドをピンセットで挟み、 ② バーコード側のピンセットを ③ 両手でスライドグラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドグラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

 

 

 

 

 

 

 

 

 

 

注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決して

マイクロアレイに触れることがないように注意してください。できる限り洗浄バッファにアレイが

浸った状態で操作し、アレイが空気に触れる時間を最小限に押さえてください。 

 

※ 参考手法 フラットピンセット 33A がない場合は、下記方法で 2 枚のスライドグラスを離します。 

2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライドを

離します。 

a. チャンバに付属の白いピンセットの先端を２枚のスライドの

間に 差し込み、ゆるやかにピンセットを上側か下側に回転

させてスライド同士を離します。 

b. ガスケットスライドのみを容器の底に落としてください。  

c. アレイスライドをすばやく取り出し、洗浄バッファ１を入れたガラス容器 2 にセットされているラックに

そっと差し込みます。 

 

  

1 2 3
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7. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。一度に洗浄するスライド

は 8 枚以下にするようにしてください。 

注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つために端は 3 つ以上、スライドグラ

ス間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは最大 8 枚洗

浄可能です。全てのスライドで、アレイ面がラックの中心を向く向きに揃えます。 

 

19 スライドラック (Thermo Shandon109) 30 スライドラック（Thermo Shandon113） 

 

 

 

 

 

 

 

 

 

 

8. 全てのスライドをラックにセットできたら,中程度の回転速度で室温のまま 1 分間 攪拌します。 

注意 アレイスライドおよびスライドラックを入れた状態で、液面が波立つ程度の速さで攪拌してくだ

さい。スライドグラスの枚数、液量によって回転数は異なるので、その都度調節してください。

回転速度が十分でない場合、洗浄力が弱まる恐れがあります。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 でスライドグラスを洗浄している間に、

ガラス容器 3 に 37℃で保温してある洗浄バッファ 2 を注ぎます。 

9. スライドラックを 37℃の洗浄バッファ 2（ガラス容器 3）にすばやく移します。中程度の回転速度（液面が

波立つ程度の速さ）で 1 分間 攪拌します。実験を成功させるために、この洗浄時間を厳守してください。 

 

10. 洗浄バッファ 2（ガラス容器 3）からスライドラックを取り出します。この時、スライドラックを平行に保ち、

スライド上に水滴が残らないように注意しながら、5-10 秒かけて引き上げてください。スライドラックを

洗浄バッファから出したり戻したりしないように注意して下さい。 

 

11. 10 の操作でスライドグラスは乾燥しますので、その後ただちにスキャンを行うことができます（窒素ガ

スによる乾燥は必要ありません）。すぐにスキャンをしない場合には、窒素パージして暗所で保管して

ください。必要でしたらスキャン後に、スライドグラスはポリプロピレンスライドボックスに入れ（コルクな

どの詰め物をしないでください）、真空デシケータまたは窒素パージボックスに入れて暗所で保存しま

す。真空デシケータの方が色素の退色が見られるため、窒素パージボックスをお勧めしています。 

注意 アレイの洗浄は、オゾン濃度が 50 ppb 以下の環境で行なってください。実験室内のオゾン濃

度が著しく高い場合には、弊社までご相談ください。 
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≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後は洗剤

を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が付着し蛍

光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗剤がつ

いていないスポンジあるいはキムワイプ（ペーパータオルは使用しないでください）でこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪ガラス容器などのメンテナンス≫ 

正しく操作されていても、汚れが洗浄器具に蓄積されるとアレイスライドに影響がでることがあります。 

スキャン画像にムラや粒上の汚れが観察されるなどの問題が起こった場合は、洗浄器具をクリーニング

すると改善する場合があります。以下の手順に従い、クリーニングをしてください。 

ガラス容器の洗浄には、アセトニトリルあるいはイソプロパノール（IPA）を用います。 

アセトニトリルは劇物なのでドラフト内で使用するなど取扱いにご注意ください。 

ステンレスラック、回転子、使用している場合はピンセットなどの洗浄器具をガラス容器に入れ、アセトニト

リルあるいは IPA を満たした状態で 5 分～数時間おきます。 

アセトニトリルあるいは IPA を廃棄した後、ミリ Q 水で洗浄器具全てを徹底的に５回以上リンスしてください。 

洗浄器具をホコリがつかない環境で自然乾燥してください。 

 

≪ミリ Q システムのメンテナンス≫ 

ガラス容器などをミリ Q 水でリンスする際、高い水質であることを確認してください。ミリ Q システムのフィ

ルターや UV ランプなどの使用期限が過ぎていると水質が悪くなり、ガラス容器などを介し、洗浄したスラ

イドグラスに影響を与えることがあります。 

参考値: 比抵抗 18.2MΩ･cm, TOC<4 
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10. Agilent スキャナを用いたスキャニング 

レーザーを安定させるためにスキャンを開始する 20 分前までに、PC、スキャナおよびスキャナコントロール

ソフトをこの順に起動しておきます。詳細な手順は、Appendix3 を参照してください。 

 

1. スキャニングの準備 

1．スライドをスライドホルダにセットします。スライドホルダをカローセルにセットした際に、数字のバーコード

面が見えるような向きで挿入します。 

a. B スキャナまたは C スキャナをお使いの場合 

 

 

 

 

 

 

 

 

 

 

≪オプション：オゾンバリアスライドカバーの使用≫ 

オゾンバリアスライドカバーを使用すると、スキャン中のオゾンによる蛍光色素の退色を抑えることができ

ます。下図のように、スライドホルダに挿入したアレイスライドに重なるように、オゾンバリアスライドカバー

を置き、スライドホルダのカバーを閉めます。 

⚫ スポット面を傷つける恐れがあるので、オゾンバリアスライドカ

バーの向き（裏表、左右の向き）に気を付けてください。 

⚫ スキャン中の退色のみに有効です。洗浄・乾燥時の退色はオ

ゾンバリアスライドカバーのみでは防ぐことはできません。 

⚫ オゾンフリーブースをご利用の場合は、使用する必要はあり

ません。 

 

b. SureScan をお使いの場合 

 

①スライドホルダのカバーを開けます。 

②’Agilent’と記載の面がホルダの上側になるように、’Agilent’の文字が奥側になるようにスライドを載せ

ます。 

 

奥のつめにのせる 

① カバーを開けます。 
② スライドを載せます。 

“Agilent”と記載の面がホル

ダの上側にくるように挿入 

ラベルが手前、 

“Agilent”と記載の面 

がホルダの上側に 

くるように挿入 
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③スライドホルダのカバーを閉めます。閉める際カチッと音がし、固く閉まっていることを確認して下さい。 

カバーのしまりが緩い場合は他のホルダを使用してください。スライドホルダは 1 台のスキャナに 24

個ついています(足りなくなりましたら購入も可能です。お問い合わせください)。 

 

2．スライドホルダをスキャナのカローセル（SureScan の場合はカセット）にセットします。複数のスライドグラ

スをスキャンする場合は、隣り合うスロットにセットしてください。また、H と書かれている Home スロット

にはセットしないでください。SureScan の場合は、どの位置にセットしても構いません。 

また、どちらのタイプのスキャナでもスライドホルダのカバーはきちんと閉めて下さい。完全に閉まってい

ない状態でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エンジニアによる

修理が必要となることがあります。 

 

2. スライドのスキャン 

スキャナコントロールソフト ver.7（B バージョンスキャナ）をお使いの場合 

(8x15K, 4x44K,2x105K, 1x244K フォーマットのスキャン) 

1. 画面下の “Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、“Start slot”と “End slot”で指定します。 

3. 設定を変更するスライドをテーブル内で選択してください(複数枚選択できます)。選択されると青くハイ

ライトされます。 

4. “eXtended Dynamic Range Scan Mode”にチェックを入れ “Hi”を 100%に “Lo”を 10%にします。 

5. “Edit Slot Values>>”をクリックしてメイン画面を拡張します。 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 
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6. 拡張された画面で、下の表に従って各種設定変更を行います。 

 

注意 Scan resolution が 5 ミクロンになっていることを必ず確認してください。 

 

7. “Output path”で、スキャン画像を出力したいフォルダを指定します。 

8. 設定が終了したら、 “Set Values”をクリックします（Set Values をクリックしないと変更が反映されませ

ん）。テーブル内の設定値が変更されたことを確認してください。 

9. スキャン設定が確認できたら、 “Scan Slot n-m”をクリックしスキャンを開始します。 

10. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

11. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

【参考】 XDR スキャン 

※ eXtended Dynamic range：XDR スキャンは、１枚のスライドグラスを、異なった PMT（4x44K フォーマッ

トの場合、高 PMT：XDR Hi 100％、低 PMT：XDR Lo 10％）に変え、自動的に連続スキャンする機能で

す。Feature Extraction 9.1 以降はこの２つのスキャンを自動的に１つにまとめ、広いダイナミックレンジ

が得られる結果を自動的に出力することが可能です。 

  

⑦ 

⑥ 
⑧ 

⑨ 

 
5 

 
Green 
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≪スキャンのデフォルト設定変更法≫ 

1. スキャナコントロールソフトを立ち上げ、ツールバーの Settings > Modify Default Settings を選択し

ます。 

2. 表示された Default Setting ボックス内で、変更したい項目を変更し、OK をクリックします。 

 

スキャナコントロールソフト ver.8（C バージョンスキャナ）をお使いの場合 

(8x60K, 4x180K,2x400K, 1x1M, 8x15K, 4x44K,2x105K, 1x244K フォーマットのスキャン) 

1. 画面下の “Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、 “Start slot”と”End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

3. “Profile”リストから、既存のプロファイルを選択します。 

 <default> プログラムインストール後に現れるデフォルト設定 

AgilentHD_GX_1Color : 遺伝子発現アレイ 1 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_1Color : 遺伝子発現アレイ 1 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_GX_2Color : 遺伝子発現アレイ 2 カラー(8x15K, 4x44K, 2x105K, 1x244K) 

AgilentG3_GX_2Color : 遺伝子発現アレイ 2 カラー(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_CGH : CGH/ChIP マイクロアレイ(8x15K, 4x44K, 2x105K, 1x244K) 

AgielntG3_CGH : CGH/ChIP マイクロアレイ(8x60K, 4x180K, 2x400K, 1x1M) 

AgilentHD_miRNA ： miRNA マイクロアレイ 

① 

② ③ 

⑤ 

④ 
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選択肢に適切なプロファイルがない場合は、ウェブからダウンロードしコントロールソフトにインポートす

るか、上記プロファイルのいずれかを選択後各項目を個別に変更してください。 

 

【プロファイルの入手およびインポート】 

1. 下記サイトから AgilentG3_GX_Profiles.zip をダウンロードし、PC に保存します（スキャナに付属

の PC ではなくて結構です）。 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Cust

om&PageID=2074  

 

2. ダウンロードしたファイルを右クリック＞Open with(プログラムから開く)＞Compressed zipped 

folders あるいは Winzip と選択し、解凍します。 

3. 解凍したファイル(AgilentG3_GX_Profiles.pfl）をスキャナに付属の PC にコピーしてください。 

4. コントロールソフトの Tool> Profile Editor…と選択します。  

5. 現れた Profile Editor 画面で Import をクリックし、保存した解凍ファイル(AgilentG3_GX_Profiles.pfl）

を指定します。  

 

6. Yes をクリックし、Profile Editor 画面の Close をクリックします。  

 

4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

 変更できる項目 

 1). Dye Channel: Red （1 カラー (Cy5)） 

   Green (1 カラー （Cy3）), 

Red+Green （2 カラー） 

 

 2 ). Scan Region: Full Slide 

Agilent HD (アジレントアレイ) 

 

 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
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3). Scan Resolution: 2um, 3um, 5um, 10um,  

double path (2um, 3um, 5um) 

※ C バージョンのスキャナでも 2um および 3um が 

選択肢にない場合は高密度タイプのマイクロアレイ 

(8x60K, 4x180K, 2x400K, 1x1M)に対応していません。 

 

4). TIFF file dynamic range: 20bit, 16bit  

 

 

 

5). R/G PMT gain: 100% ～ 1% 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

NoXDR 

7). Output Path:  

※ 変更した設定は Profile に保存することができます。 [Profile>Save as] 

 

5. スキャン設定が確認できたら、”Scan Slot n-m”をクリックしスキャンを開始します。 

6. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

【参考】 16bit スキャンと 20bit スキャン 

※TIFF ファイルに保存されるシグナル強度範囲を指定します。 

20bit スキャンは、1 回のスキャンで 5 桁のダイナミックレンジでシグナル強度を保存できます。XDR スキャ

ンは不要なため、20bit スキャンを選択すると XDR 機能はオフになります。 

16bit スキャンは、1 回のスキャンでは遺伝子発現のダイナミックレンジをカバーしきれないため、XDR 機能

を使って 2 回の PMT gain の異なる連続スキャンを行ない、その結果を統合して使います。この場合、XDR 

ratio を指定する必要があります。遺伝子発現のデフォルトの XDR ratio は 0.1 です。 

20bit で 1 回スキャンしたデータと 16bit で XDR スキャンしたデータは、結果にほぼ違いはありません。 
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スキャナコントロールソフト ver.9.1（SureScan マイクロアレイスキャナ）をお使いの場合 

注意 ドアを手で開けないてください。エラーが発生します。 

カセットを手で動かさないでください。エラーが発生します。 

エラーが発生したら、スキャナコントロールソフトウェアを再起動する必要があります。 

1. 起動すると次の画面になります。 

 

 

 

 

2. 初期化が終了すると、ファンクションボタンのOpen Doorボタンがアクティブになります。クリックし、カセ

ットにスライドをセットします。スライドがセットされているカセットは青色で表示されます。また、各パラメ

ータの編集ができるようになります。 

 

  

スライドがセットさ

れると青色で表示

されます。 
プロトコルファイルを選択

します。 
データの保存先を指定します。 

スロットステータス

インジケータ 

ファンクションボタン 

セッティングペイン 

ステータスバー 

メニューバー 

スロットテーブル 

ログ 
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3. Scan Protocolから適切なプロトコルファイルを選択します。AgilentG3_HiSen_GX_1Colorまたは

AgilentG3_HiSen_GX_2Color（1x1M、2x400K、4x180K、8x60Kの場合）あるいは、

AgilentHD_HiSen_GX_1ColorまたはAgilentHD_HiSen_GX_2Color（1x244K、2x105K、4x44K、

8x15Kの場合）を選択します。 

ウィンドウ右側のセッティングペインでスキャン設定を確認してください。プルダウンに

AgilentHD_HiSen_GX_1ColorまたはAgilentHD_HiSen_GX_2Colorがない場合や、設定を変更する

必要があれば、ウィンドウ右側のセッティングペインで個別にプルダウンメニューで変更できます。

AgilentHD_GX_1ColorまたはAgilentHD_GX_2Colorを選択した場合はResolutionを”5 um”から”5 

um high sensitivity”に変更してください。この設定をScan Protocolとして保存する場合は次ページを

ご参照ください。 

 

4. 必要があればデータの保存先を変更します。※D drive内のフォルダを指定してください。 

 

 

 

5. ファンクションボタンのAll to Queueボタンをクリックし、ステータスバーでScannerのステータスが

Readyであることを確認します。 

6. ファンクションボタンのStart Scanボタンをクリックするとスキャンを開始します。 

7. スキャンが終了し、Open Doorボタンがアクティブになったら、クリックします。 

8. スライドホルダを取り出します。 

9. コントロールソフトを閉じた後にスキャナおよびPCの電源を消してください。 
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≪変更したプロトコルをScan Protocolとして保存する場合≫ 

1． メニューバーの Tools から”Scan Protocol Editor…”を選択します。  

2． AgilentHD_GX_1Color または AgilentHD_GX_2Color を選択し Scan Protocol Editor 画面下部の”

Save As”をクリックし、”Save As New Name”ボックスで、今から設定する新しい Protocol Editor に

分かりやすい名前（例：AgilentHD_HiSens_GX_1color）をつけて保存します。  

3． 設定した新しい名前の Protocol が選択されているのを確認した後、Resolution という項目のプルダウ

ンメニューを展開し、”5 um”から”5 um high sensitivity”に変更してください。 

 

 

4． Resolution が間違いなく High Sensitivity に設定されており、その他の項目に変更が加えられていな

いことを確認した後、ボックス下部の Save をクリックします。  

今後のスキャン時には、この新規作成した Protocol を Scan Protocol として選択するだけで、高感度設定

でスキャンをすることが出来ます。  
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ログスケール 

リニアスケール 

切り替えボタン 

11. ハイブリダイゼーション後のマイクロアレイの画像化 

ここでは、Feature Extraction ソフトウェアによるイメージの簡単な確認法をご紹介します。より詳細につい

ては、Feature Extraction 英語版マニュアルをご覧ください。 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

 

① Feature Extraction ソフトウェアの起動 

以下のいずれかの方法で、Image Work Window を開き、TIFF イメージを確認します。 

⚫ tif イメージファイルをデスクトップの Feature Extraction ショートカット  にドラッグ＆ドロップ 

⚫ Feature Extraction ショートカット     をダブルクリックしてソフトを起動後、メニューバーの 

【File>Open > Image】で開きたいファイルを指定 

 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

③ 表示カラーの変更 

Color > xxxxx を選択すると表示カラーが変更します。 

例：メニューバーの【Color > Reverse Gray Scale】を選択すると、白黒反転表示になります。 

  

白黒反転表示白黒反転表示
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④ イメージデータのスケールの確認 

Green チャンネルのデータレンジを確認します。 

注意 ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認する）

ためには、スポット定量が必要になりますので御注意ください。 

 

カラーレンジの設定 

 をクリック。 

イメージデータ全体に対し、１％から９９％の設定 

（デフォルト）における最大値・最小値を確認します。 

 

 

⑤ クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると

新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウ

ィンドウが拡大表示されます。 

をクリックすることで ON/OFF の切り替えができます。 

 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

クロップモードを ON にしたまま、ラインプロットを見たい領域の左上隅で左クリックし、そのままポインタを領域

の右下隅までドラッグさせます。次にクロップモードを OFF にし、ラインプロットを見たい位置（上の図の場合、

赤線上のどこでも構いません）にポインタを合わせてダブル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可

能性となる異常スポットやバックグランドの確認をすることができます。
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12. Feature Extractionソフトウェアで数値化を行う前に 

①Project Work Window を開く 

以下のいずれかの方法で、Project Work Window（スポットの数値化の画面）を開き、必要なファイ 

ルがあるかどうかを確認します。 

 

⚫ メニューバーの【File > New > Standard Project】を選択 

⚫ Feature Extraction シ ョ ー ト カ ッ ト     をダブルクリック 

 

 

Project 

Explorer 

Pane 

Project Work Window 

Grid Template Browser 

FE Protocol Browser 

QC Metric Set Browser 
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②必要なファイルの確認 

Grid Template Browser： インストール済みのデザインファイルまたは Grid File のリスト表示。ここにこ

れから数値化するマイクロアレイの種類に対応したデザインファイルがある

か確認する。 

確認方法： (1) マイクロアレイのデザイン ID を確認する 

デザイン ID … アレイスライドのラベルに印字されている、または TIFF ファイルのファイル

名に記載の 25 から始まる 12 桁の番号の、25 に続く 5 ケタの番号に 0

を付けた 6 桁の番号(252800410025 であれば 028004 がデザイン ID) 

(2) Grid Template Browser に目的のデザイン ID のファイルがあるかを確認する 

（028004_D_F_20110524 等） 

必要なデザインファイルがなければ、eArray からダウンロードする(巻末の Appendix3 参照)。 

デザインファイルは、各プローブのマイクロアレイ上の位置情報と、対応する遺伝子の情報を含んだファイ

ルです。ファイル名の末尾の日付はファイルの更新日付で、更新されると遺伝子の Annotation 情報は変

更されることがあります。より新しい情報でデータ解析をしたい場合、既にデザインファイルが存在しても、

eArray からダウンロードした最新のデザインファイルをお使い下さい。(GeneSpring で解析をする場合、

Annotation 情報はデザインファイルの情報に依存しないため、新日付は古くても問題ありません) 

FE Protocol Browser： 各数値化ステップのアルゴリズムのパラメータを含む、アプリケーションごとの

ファイル。ダブルクリックで開いて変更・保存可能。 

FE プロトコル例） GE1_107_Sep09 

GE1 … 遺伝子発現 1 カラーアレイ用 

GE2 … 遺伝子発現 2 カラーアレイ用 

CGH … アレイ CGH 用 

ChIP … ChIP-on-chip 用 

miRNA … miRNA アレイ用 

107 … このプロトコルファイルが対応している Feature Extraction のバージョン 

（お使いのソフトウェアのバージョンに合った FE プロトコルを使って下さい） 

Sep09 … ファイルの更新時期（より新しいものを使って下さい） 

NonAT … アジレント製以外のアレイデータを数値化する時に必要。 

必要な FE プロトコルファイルがなければ、ダウンロードする(巻末の Appendix 4 参照)。 

QC Metric Set Browser：各アプリケーションでの QC メトリック（実験の成否判断の閾値）のセット。 

Feature Extraction10 以降で数値化すると、いくつかの実測値が、アプリ

ケーションごとに設定された閾値の範囲内かどうかを QC レポートに自動

出力されます。 

必要なメトリックセットファイルがなければ、下記 Web Site からダウンロードすることが可能です。

https://www.agilent.com/en/qc-chart-tool-metric-sets   
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③必要なファイルのインポート 

■ Grid Template Browser 内に新規デザインファイルを加える場合 

（この操作は Feature Extraction に必要なデザインファイルがない場合、もしくはより新しいデザインファイ

ルで数値化したい時のみ必要になります） 

 

(1)eArray から必要なデザインファイルをダウンロードする(巻末の Appendix4 参照)。 

(2)ダウンロードしたデザインファイルを解凍し、XML ファイルを“日本語が入らないパス”のフォルダに保

存する。 

※ 圧縮ファイルを解凍する際は、Winzip あるいは Windows XP 以降に付属のソフト（解凍するファイル

上で右クリック＞Open with（プログラムから開く）＞ 

Compressed(zipped)Folders（XP）または Explorer（windows7）を選択）を使用してください。 

(3)Grid Template Browser Pane 上で右クリック→Add…を選択後、目的のデザインファイルを選択。

（または、メニューバー【Tools > Grid Template > Add…】を選択後、目的のデザインファイルを選択） 

 

■ FE Protocol Browser 内に新規 Protocol を加える場合  

（この操作は Feature Extraction に必要な FE プロトコルがない場合のみ必要になります） 

(1)FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選択して下

さい。 

（または、メニューバー【Tools > FE Protocol > Import…】を選択後、目的の Protocol を選択） 

 

■ インポートしたデザインファイルに、適切な FE プロトコルを設定する方法 

（この操作は新しいデザインファイルをインポートした時のみ必要になります。 

必要な FE プロトコルが数値化時に毎回自動で割り当てられるようになるため便利です） 

 

(1)Grid Template Browser Pane に格納されている目的のデザインファイルを選択する。 

(2)ダブルクリック（または、メニューバー【Tools > Grid Template > Properties】を選択）して、FE Grid 

Template Properties（右図）の window を開く。 

 

(3)Default Protocol（2 カラーデータ用）、 

Default One Color Protocol に適切な Protocol を 

指定します。 
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13. Feature Extraction ソフトウェアによる数値化 

STEP1. Feature Extraction ソフトウェアの起動 

以下のいずれかの方法でProject Work Windowを立ち上げて、スポット数値化を行います。 

⚫ デスクトップのFeature Extractionショートカット  をダブルクリック 

⚫ 【Start>Programs>Agilent >Feature Extraction】 からソフトウェアを開始 

 

STEP2. FE projectへ数値化するイメージ(.tif)を追加 

ツールバーにあるAdd New Extraction Set(s)のアイコン を クリックします。あるいは、Project 

Explorer内で、右クリックをし、Add Extraction…を選択します。 

 

1. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

※ XDR設定でスキャンしたtif画像は、2種類 （HおよびL) のScan Fileがイメージファイルとして認識さ

れます。その際、HおよびLのScan Fileが、同一フォルダ内に存在する必要があります。 

 

2. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage 

File、Grid File、Protocolが現われることを確認して下さい。空欄の項目がある場合、適切なGrid 

TemplateとProtocolを選択してください（次頁参照）。 

 

Project： Feature Extraction の Run 設定全体をまとめた情報です。 

1 つ以上の Extraction Set から構成されています。 

Extraction Set： 解析する tif 画像ごとに作成されます。 

Image File、Grid Template (Grid File)、Protocol から構成されています。 

Image File ：解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File) ：Grid情報です。Agilent アレイの場合はデザインファイルを意味します。 

Protocol ：イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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STEP3. 数値化設定の確認とProjectの設定 

１.数値化設定の確認をします。 

⚫ Project Work Window中央のExtraction Set Configurationタブシートを選択。 

 

⚫ Extraction Setで用いる構成（TIFFイメージ、デザインファイル、Protocol）を確認します。 

空欄になっている場合、プルダウンから選択することができます。またプルダウン内にも必要なフ

ァイルが表れない場合、p.52-53を参照の上必要なファイルをインポートして下さい。 

 
2. Projectの設定、出力ファイルの設定を行います。 

⚫ Project Propertiesタブシートを選択する 

あるいは、Project Explorer内の解析に用いる 

Projectをダブルクリック。 

⚫ Projectの設定を確認、変更をします 

（解析結果ファイルのOutputフォルダの設定、 

結果としてOutputするファイル種類の設定など）。 

 

 

 

（ソフトウェアのデフォルト設定を変更したい場合は、メニューバー【Tools > Preference】で設定画面を開き、

【FE Project> Output & Data Transfer】を選択して下さい）
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(1)出力方法の設定 

出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

デフォルトでは、TEXT、Visual Results、QC Reportの結果が出力されるよう、これらの項目の設定が

Local file onlyとなっています。また、それ以外の項目（MAGE、JPEG、Grid）は、Noneとなっています。 

(2)出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用す

る場合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

TEXT アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使

用する場合に必要。 

※TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full： 数値化項目全ての結果を出力します。 

Compact： 数値化項目の一部（通常、データ解析に用いると考えられる項目）の

結果を出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, Agilent Genomic workbenchを使用する場合はCompact推奨。 

Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは”Local PDF file only”を、HTMLファイルは””Local HTML file only”

を選択してください。HTMLファイルの場合は数値化後、必ずQCReport_Graphsと

いうフォルダと同じフォルダにHTMLファイルを保存してください。 

 

(3)QCメトリックの設定（ver.10.7より前のバージョンをお使いの場合） 

Project Propertiesタブシート一番下部“Other”の“QC metric set”プルダウンから“GE1_QCMT_Jan09”

を選択します。 

プルダウンに“GE1_QCMT_Jan09”が表示されない場合https://www.agilent.com/en/qc-chart-tool-metric-

setsからファイルをダウンロードし、QC Metric Set Browser上で右クリックしてファイルを追加して下さい。 

 

3. 設定を確認したら、Projectの保存を行います。 

⚫ メニューバー【File > Save As】を選択し、FE Project Data Files (.fep)ファイルを保存するための適切

なフォルダを選択もしくは作成して下さい。 

⚫ フォルダ指定後、Projectに名前を付けて保存して下さい。  
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STEP4. Feature Extraction Projectをスタート (数値化の実行) 

⚫ メニューバー【Project > Start Extracting】またはProject Run Mode On/Offボタン を選択す

ると、Projectがスタートします。スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※ 4x44K及び4x180K フォーマットの出力結果は、ファイル名末尾 “…_1” ～ “…_4” の4つのデータが得ら

れます。8x15K及び8x60K フォーマットの出力結果は、ファイル名末尾 “…_1_1” ～ “…2_4” の8つのデ

ータが得られます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイドが手前の状態)。 

 

 

 

 

 

1 2 3 41 2 3 4
1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4

 

Running MonitorRunning Monitor

 

Project 終了後Project 終了後
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Step 5—QC Reportの確認 

 

1. 出力ファイルの設定で、QC Reportを選択した場合に自動でQC Reportが作成されます。 

2. “pdf形式のQC Reportファイル”を開いて下さい。QC Reportを確認することができます。 

 

QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guideの各ページで確認することができます。） 
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出力された

QC metrics

のテーブル 
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Step 6—Visual Resultの確認 

 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、画像を表示させます。XDRスキャンをした場合は、ファイル名の末尾に_Hが付

いた画像を表示させます。メニューバーのFeature Extraction > Load Visual Resultを選択します。 

2. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

3. 画像にVisual Resultが重ね描きされます。 

4. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

5. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

 

 

 

 

 

 

 

View outliers onlyにチェックが入っている状態 

 

 

 

 

 

 

 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 
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Step7. —テキストファイルの確認 

以下の表は、Compact 設定で出力されたテキストファイルの主な項目です。 

通常データ解析では gProcessedSignal をシグナル値、ProbeName を ID として使用します。 

これらの項目は数値化テキストファイルをエクセルで開くと、10 行目に表示されます。GeneSpring GX

をご使用の際は、出力ファイルの内容は変更せず、出力テキストファイルをそのまま GeneSpring に認

識させてください。 

 

 

項目(Green) 項目(Red) 内容 

 

FeatureNum フィーチャ番号 

ControlType フィーチャのコントロールタイプ 

ネガティブおよびポジティブコントロールは

数値化の際に Feature Extraction が各種

補正係数などを計算する際に使用します。

生物学的な解析には必要ありません。 

0 コントロールプローブ以外のプローブ 

-1 ネガティブコントロール 

1 ポジティブコントロール 

ProbeName 各 60 mer の配列に対応した Probe ID 

SystematicNam 各プローブがターゲットとしている配列の

ID。可能な限り公的なデータベースの ID

を使用。 

gProcessedSignal rProcessedSignal 全ての数値化プロセスを経たシグナル強

度。1 色法の場合は、Surrogate 後の値、

2 色法の場合は色素補正後の値。 

gBGSubsignal rBGSubsignal バックグランド補正を行った後、各種補正 

を行う前のシグナル強度。 
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Feature Extraction 由来のフラグ 

 

 

項目(Green) 項目(Red) 内容 

 

gIsSaturated rIsSaturated 0 サチュレーションしていないフィーチャ 

1 サチュレーションしているフィーチャ 

gIsFeatNonUnifOL rIsFeatNonUnifOL 各フィーチャ内のシグナルの均一性を 

検証。 

0 フラグが立っていないフィーチャ 

1 フラグが立った不均一なフィーチャ 

gIsFeatPopnOL rIsFeatPopnOL アレイ内に繰り返し搭載されている同じ 

配列を持つプローブシグナルの均一性を 

検証。1 回しか搭載されていないプロー 

ブは対象外。 

0 フラグが立っていないフィーチャ 

1 フラグが立ったフィーチャ 

gIsPosAndSignif rIsPosAndSignif フィーチャのシグナルがバックグランドと 

有意に差があるかを判定。判定法は両 

側t検定。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 

gIsWellAboveBG rIsWellAboveBG フィーチャのシグナルがバックグランドと 

有意に差があるかを判定。BGSubsignal 

の値が、バックグランドの標準偏差（エラ 

ーモデルから算出）を各アレイフォーマッ 

トの最適値倍（デフォルトは13倍）した値 

よりも大きいかどうかで判定。 

PosAndSignifよりも厳しい判定法。 

0 バックグランドと差がないフィーチャ 

1 バックグランドと差があるフィーチャ 
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スポット数値化と解析 

DNA マイクロアレイの解析には 2 種類のソフトウェアを使用します。 

 

まずスキャンで得た TIFF イメージからスポットの数値化を行うソフトウェアが必要になります。ここで

はスポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent ス

キャナに付属する Feature Extraction はこれに加えてバックグランドの引き算を行い、最終的なシ

グナル強度（Processed Signal）を結果として出力します。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。

データ解析を行うソフトウェアは数多く製品化されていますが、生物学的意義を付け加えていくため

にアジレントでは GeneSpring GX を推奨しています。 

 

   Feature Extraction など        GeneSpring GX など 

 図：スポット解析、データ解析の流れ 

 

 

スポットの数値化は以下の手順で行われます。 

①  スポットの中心位置の決定 

② スポット（Feature）およびバックグラウンド領域の決定 

③ スポット（Feature）のシグナル強度計算 

④ バックグランドのシグナル強度計算 

⑤ バックグランド補正 

⑥ Multiplicative Detrending 

これらのステップ後、最終的なシグナル強度（Processed Signal）が出力されます。 
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Appendix1：total RNA の品質チェック 

Step1．UV-Vis による total RNA の評価 

本プロトコルでは、測定に用いるサンプル量を抑えるため、NanoDrop の使用をお勧めいたします。 

NanoDrop を使用する場合は、メニュー画面で Nucleic Acid Measurement をクリックし、Sample 

Type は RNA-40 と選択します。 

・少なくとも、以下の 4 つの波長における吸光度を測定して下さい。 

A230      グアニジンイソチオシアネートや塩類・糖類、その他有機溶媒などの混入を検出します 

A260      TotalRNA の濃度を測定します 

A280      タンパク質・フェノールの混入を検出します 

A320      異常な吸収がないかをチェックします 

・以下の基準を満たしているかをチェックして下さい。 

A260/A280＝1.8～2.0   A260/A230>2.0  

この基準を満たしていない場合、タンパク質や有機溶媒の混入が疑われ、ラベル化反応がうまくい

かないことが予想されます。また、RNA を正確に定量できていない可能性もあります。抽出をやり

直すか、混入物を除去するための追加の精製を行って下さい。 

 

・UV スペクトルを採取し、スペクトルパターンを記録して下さい。 

純度の高い核酸のスペクトルは、230nm に谷、260nm に吸収極大があり、長波長側の吸光度は 0

で安定しています。 

 

Step2．Agilent 2100 Bioanalyzer による total RNA の評価 

UV-vis の測定結果からは RNA がどのぐらい分解しているかを知ることはできません。必ず電気泳

動で RNA が分解していないか、確認してください。本プロトコルでは、Agilent 2100 Bioanalyzer を

推奨しています。 

Agilent 2100 Bioanalyzer を用いる場合は、サンプルの濃度に応じて、RNA6000 Nano kit あるいは

Pico kit を使用してください。実際の操作は各キットの説明書に従ってください。 

電気泳動の結果から下記 3 点を確認し、分解していないか評価してください。 

⚫ 18S および 28S リボソーマル RNA（あるいは生物種特有の rRNA）の明確なピークが確認できる 

⚫ 18S および 28S リボソーマル RNA のピーク間に分解物がない 

⚫ 18S リボソーマル RNA ピークと Lower Maker 間に分解物がない 

（5S リボソーマル RNA は精製法によって高さが変わります。カラムを用いて total RNA を精製した場

合、通常低くなります。） 

Agilent 2100 Expert Software は、total RNA の品質の指標として RNA Integrity Number（RIN）を自

動で算出します。RIN を使うと、RNA の分解具合などの品質の標準化が容易になります。 

RINやBioanalyzerに関するより詳細な情報は、以下のウェブサイトより、“RNA integrity number(RIN)-

Standardization of RNA quality control” (part number 5989-1165EN) を ご 覧 下 さ い 。

www.agilent.com/chem/labonachip

http://www.agilent.com/chem/labonachip
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下の図では、分解具合の異なる 3種類の total RNAを分析した結果のエレクトロフェログラムを示しています。

お客様が、品質の悪い total RNA による実験結果の偏りを排除するために、RIN の各々の閾値を実験系ごと

に決定することが重要となります。 

 

 

 状態の異なる（ヒト）total RNA を Eukaryote Total RNA Nano assay によって分析した結果 

赤…RIN 8.1 青…RIN 5.9 緑…RIN 3.6 
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Appendix2：サーマルサイクラーを用いた実験プロトコル 

 

ウォーターバスの数に限りがある場合、PCR チューブ及びサーマルサイクラーを用いて実験をすることも可能

です。ただし、1.5 mL チューブを使用した場合と比べると、cRNA の収量は少し下がる傾向があります。 

 

Step1.サーマルサイクラーのプログラム設定 

下記のようにプログラムを設定します。 

プログラム 1：65℃ 10 分、4℃ hold 

プログラム 2：40℃ 2 時間、70℃ 15 分、4℃ hold 

プログラム 3：40℃ 2 時間、4℃ hold 

4℃のステップは 5 分で十分です。次のステップの準備が整っていない場合は、4℃に置いてください。 

Heat Lid の設定にしてください。 

 

Step2.total RNA からの cDNA 合成 

1．25ng から 200ng の total RNA を PCR チューブあるいは 96 穴 PCR プレートに加えます。最低 25ng の

total RNA を用いてください。 

2．2uL の希釈した Spike-Mix を加えます。Spike-Mix の希釈手順については、p.16 をご覧ください。 

3．p.17 の表に従い、T7 Promoter primer Mix を調製します。 

4．1.8uL の T7 Promoter primer Mix を各チューブに加え、よく混ぜます。総量は 5.3uL になります。 

5．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 1 を走らせ、

熱変性を行います。 

6．65℃ 10 分の過程が終了したら、氷上に移します。 

7．p.18 の表に従い、cDNA Master Mix を調製します。 

8．4.7uL の cDNA Master Mix を各サンプルに加え、ピペッティングで良く混合します。総量は 10uL になりま

す。 

9．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 2 を走らせ、

cDNA 合成反応をスタートします。 

 

Step3.ラベル化 cRNA の合成 

1．1.5mL のチューブに、p.19 の表に従い Transcription Master Mix を調製します。使用直前に T7 RNA 

polymerase Blend をマスターミックスに加えます。ピペッティングで良く混合します。 

2．サンプルはマスターミックスを添加するまで、サーマルサイクラー中で 4℃、あるいは氷上に置きます。 

3．各サンプルに、6uL の Transcription Master Mix を加え、ピペッティングで良く混ぜます。 

4．サーマルサイクラーに PCR チューブあるいは 96 穴 PCR プレートをセットします。プログラム 3 を走らせ、

cRNA 合成反応をスタートします。 

5．p.20 に従い、ラベル化 cRNA を精製します。その後の操作は、1.5mL チューブでラベル化を行った場合と

同じです。 
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Appendix3：詳細なスキャナの起動手順 

 

B スキャナまたは C スキャナをお使いの場合 

1. PC の電源を入れログインします。 

2. PC が完全に立ち上がってからスキャナの電源を入れます。 

3. スキャナ前面の LED が緑とオレンジに点灯している（点滅ではありません）ことを確認します。電源を

入れてから数分かかります。 

4. スキャンコントロールソフトを立ち上げます。スキャナと PC の通信が始まってから、レーザーが安定

するまで 20 分ほどかかります。 

 

SureScan をお使いの場合 

1. PC の電源を入れログインし、スキャナの電源を入れます。 

2. スキャナ前面右上にある LED がオレンジ→白色の順に光り、しばらくすると消灯します。LED が消灯

するまで待ちます。（電源を入れてから数分かかります。） 

3. スキャンコントロールソフトを立ち上げます。 

4. スキャナの初期化が始まりますので、初期化が終わるまで待ちます。 

5. スキャンコントロールソフトの画面右下にある Scanner Status が Ready になることを確認します。 

※デフォルト設定では、Ready の状態で 5 分間、スキャン開始せずに待機すると、省電力のためレー

ザーが OFF になります。スキャンのために Queue に入れるとレーザーが自動点灯し、Status が

Ready になります。 

 

 

いずれのスキャナでも、スキャン後はスライドフォルダを取り出し、コントロールソフトを閉じてください。そ

の後スキャナおよび PC の電源を落としてください。 

 

通信エラーが起きた場合などは、PC とスキャナの電源を切った後 10～15 分ほど待ち、上記手順で PC

とスキャナの再起動をお試しください。それでも改善しない場合は、エラー内容を弊社サポート窓口まで

お知らせください。 
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SureScan で’Initialize logger failed’のエラーが出た場合の対処法 

 

SureScan の場合、スキャンコントロールソフト を立ち上げた際に以下のエラーメッセージが出て、スキャ

ナ本体と通信できない事がありますが、次の手順でエラーを解消することができます。 

 

 

1. 上記のエラーメッセージの OK を押します。 

2. スキャンコントロールソフトで Tool > Log files と選択し、ログファイルのフォルダを開きます。 

3. スキャンコントロールソフトを終了し、装置の電源もオフにします（PC の再起動は必要ありません）。 

4. 上記 2 で開いたフォルダ、C:\ProgramData\Agilent\MicroArrayScanner\Logs  の中にある、

ExceptionLog.txt というファイルをデスクトップなど別のフォルダに移します。 

5. 再度、スキャナ本体の電源をオンにし、スキャナ右上の LED ランプが黄色に点灯し消灯後、スキャ

ンコントロールソフトを立ち上げてください。 

6. 移動した ExceptionLog.txt は元の場所には戻さず、破棄して下さい（スキャンコントロールを立ち上

げた際に Log のフォルダには既に新しい ExceptionLog.txt が作成されています）。 

 

C ドライブ中に ProgramData がない場合、ProgramData が隠しファイルになっていますので、下記の方法

で表示ください。 

【Windows 7】 

a)     スタートメニューから [Control Panel ] を選択 

b)     [ Appearance and Personalization ] を選択 

c)     [ Folder Option]を選択 

d)     [ Folder Option] ダイアログが表示されるので、[ View ] タブを選択 

e)     [ Advanced Settings] の[ Hidden files and folders ]の中で[ Show hidden files, folders, and drives ] 

を選択し、apply 

【Windows 10】 

a)     スタートメニューから Explore を選択、またはスタートメニューを右クリックし File Explore を選択 

b)     現れた Explore ウィンドウで View タブ を選択 

c)     File name extensions および Hidden items にチェックを入れる 
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Appendix4: Feature Extraction用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

 【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載さ

れている 12 桁の番号の「25」に続く 5 桁の番号

の頭に「0」を付けた 6 桁の番号。この 12 桁の番

号は Feature Extraction の出力ファイルからも

確認できます。 

 例） 12 桁の番号が 251469312345 の場合… [14693]の頭に「0」を付けた 014693 

 

 

 

2．eArray にログイン後、画面右上の 

「Application Type」を Expression に変更 

 

 

 

 

 

 

 

3．HomeタブでMicroarrayにチェックを入れ、Design ID

欄にデザイン番号を入れてSearch。 

 

 

 

 

 

 

4．Search 結果から「Download」を選択 

http://www.chem-agilent.com/contents.php?id=29443
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5.Internet Explorer の Pop Up Blocker   

を Off にし、 「EXTERNALFULGEML」  

（＝Feature Extraction 用デザインファ  

イル）をダウンロード 
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Appendix5: Feature Extraction用 Protocolのダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値

化に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

 

https://www.agilent.com/en/download-protocols-feature-extraction-software 

 

 

 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ 

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

  

https://www.agilent.com/en/download-protocols-feature-extraction-software
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Appendix6：1 color 実験の Normalization 

 

１color 実験で得られた複数のアレイデータを相互比較するためには、Normalization（正規化）が必要で

す。 

2 つのサンプルを異なる色素でラベル化し、競合ハイブリダイゼーションさせる 2color 実験では、基本的

に Dye Normalization（色素補正）が適用されますが、1 color 実験では、データの特徴と実験の目的

（実験デザイン）を考慮して、適切な Normalization 方法を選択する必要があります。 

ここでは、1 color 実験の Normalization の基本的な考え方を理解するために、GeneSpring GX の設定

を例として、代表的な Normalization シナリオを紹介します。 

 

Normalization Step 

Normalization を行う Step は、大きく分類すると、Normalization Option、Baseline  Option の 2 種

類あります。 

- Normalization Option は、アレイ間のシグナル強度の系統的な誤差を補正して、生物学的な変動を

抽出することが目的です。 

- Baseline Option は、サンプル間の遺伝子発現の絶対値ではなく、発現パターンの違いに着目して

解析し、生物学的な意味を引き出すために行います。実験デザインにあわせた設定をする必要があり

ます。 

 

これらの Normalization Step 中には、様々な Normalization のアルゴリズムが存在します。 

下記に、Normalization Step に含まれる代表的な Normalization アルゴリズムを示します。 

実験デザインに応じて、適切な Normalization アルゴリズムを含んだ Step を組み合わせ、

Normalization シナリオを作成します。 

 

Normalization Option 

・【Percentile Shift】 – アレイごとに、測定値の Median または特定の Percentile の値を１に揃えます。 

・【Quantile】 – 発現値をランキングし、同じランクの値の平均値を発現量として使用します。 

・【Scale】 – サンプルの中央値を使って補正します。 

・【Normalize to Control Genes】 – アレイごとに、ポジティブコントロールの測定値の Median で補正し

ます。この補正は、ポジティブコントロールのターゲットとプローブが、いかなる条件下でも一定量のハイ

ブリダイゼーションを示し、かつハイブリダイゼーションの効率がポジティブコントロールの遺伝子群と、

その他の遺伝子群で同等であるという前提に基づいています。 

 

Baseline Option 

・【Do not perform baseline transformation】：補正しません 

・【Baseline to median of all samples】： 発現の絶対量にかかわらず、発現量の変化（発現パターン）に 

着目して解析する場合に使用します。明確なコントロールサンプルが存在しない 

場合に使用します。 
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・【Baseline to median of control samples】：コントロールサンプルに対する各遺伝子の発現量の増減

に着目して解析する場合に使用します。 

 

―解説 

Normalization 

図１に示した Raw Data の分布を表したヒストグラム（シグナル強度を縦軸においたヒストグラム）では、

他の Sample に比べて、Sample ４（S4）のシグナル強度が、全体的に高くなっています。この場合、

Sample ４の真の遺伝子発現が全体的に高いことも考えられますが、この仮定が妥当なものとみなされ

ない場合は、このシグナル強度の違いは、RNA 抽出・ラベル化・ハイブリ・洗浄・スキャニングのムラな

どの実験誤差による影響だと考えられます。 

Normalization は、１枚のアレイ全体のシグナルレベルを補正し、実験誤差による影響をキャンセルする

ことで、生物学的な変動を抽出することを目的としています。 

【Scale】・【Percentile Shift】は、多数の遺伝子を網羅的に搭載したアレイデータを使った場合、大多数

の遺伝子の発現量に変化がなく、その中央値や Percentile 値は各アレイ間でほとんど変動しないとい

う仮定に基づいています。その仮定をもとに、各アレイでの発現強度の Median 値などを使い、全遺伝

子の発現強度（シグナル強度）を割って補正を行います。いわゆるグローバルノーマライゼーションにな

ります。 

この Normalization の結果、Median 値や Percentile 値が 1.0 となる Normalization 値が算出され、各

アレイ（Sample）間のシグナル強度を相互比較することが可能になります（図 1）。 

 

※ アジレントのカタログアレイでは、コントロールプローブを除いた全プローブの 75%tile

の値が Median の値よりも堅牢であり、この目的の補正には 75%tile の値を使うことを

推奨しています。 

（http://www.nature.com/nbt/journal/v24/n9/full/nbt1241.html をご参照下さい） 

http://www.nature.com/nbt/journal/v24/n9/full/nbt1241.html
http://www.nature.com/nbt/journal/v24/n9/full/nbt1241.html
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【注意】対象となる生物種の遺伝子を網羅することを目的としてデザインされたアレイでは、搭載されてい

るプローブ数に比べて、実験に用いる Sample で真に発現している遺伝子が少ない場合があります。こ

の場合、真に発現していない遺伝子プローブが、シグナル強度が低い領域に多数存在し、その割合の

違いが Median の値に影響を与えます。 

この影響を避けるには、発現していないとみなされるフラグがたったプローブを除いて、Median を計算

する方法があります。またフラグが自動的に付かない数値化ソフトウェアを使用している場合は、各

Sample で適切な Percentile（例：75 percentile）値を検討してもよいでしょう。 

 

（参考） 

比較したいサンプル間で、遺伝子の発現量の Median 値が一定であるという仮定が成立しない場合、

Normalization 【Percentile Shift】や【Scale】は適切なアルゴリズムではありません。 

仮定が成立しない例として、下記の場合が考えられます。 

 

1. 遺伝子数が少なすぎる（Median や Percentile 値が信頼できない） 

2. 特定の遺伝子のみを意図的に集めたテーマアレイ（大部分の遺伝子の発現が変化する） 

3. 大多数の遺伝子の発現を変えるような状態、あるいは処理を行った 

 

このような場合には、【Normalize to Control Genes】が選択肢のひとつとして考えられます。Control 

Gene は、ハウスキーピング遺伝子に代表される遺伝子群（常に一定のレベルで発現していることが期

待される遺伝子群）や、一定量に調製されたスパイクコントロールサンプルに対応するプローブなどがあ

ります。ただし、この方法は個々の Control Gene の発現レベルが変動した場合、結果に大きな影響を

与えます。ハウスキーピング遺伝子群を用いる場合は、できるだけ多くの Control Genes を設定し、そ

の Median 値を使うと、より保守的な Normalization になります。 

Median ( 50 percentile)

S 1 S 2 S 3 S 4

1.0

S 1 S 2 S 3 S 4

Per Chip: Normalization to median

適用後

Raw Data

図1. Per Chip: Normalize to median (50 percentile)
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Baseline Option 

Normalization の後に、サンプル間の遺伝子の発現量の違いではなく、発現パターンの変化に注目して、

生物学的な意味を抽出するのを助ける目的で行います。発現量の多少にかかわらず、同じときに発現

量が増えたり減ったりしている遺伝子は、①機能的に近い関係にある、②同じ転写制御の元にある、③

同じカスケードの下流にある、といった仮定にもとづいて解析を行う場合に有効です。逆に、この

Transformation により、すべての遺伝子が１の周りの変動に収束するので、発現量の絶対値に注目し

た解析を行う場合は、この Transformation Step は必要ない、もしくは不適切な場合があります。 

 

例１ 明確なコントロールサンプルがない場合 

【Baseline to Median of all samples】は、特にコントロールサンプルが存在しない実験デザインの場合

に用います。 

Baseline to Median of all samples の計算例を図 2 で示します。図 2 は、5 つの Sample 中での、遺

伝子 A と遺伝子 B の動きを示しています。遺伝子 A では S5 の値が、遺伝子 B では S3 の値が Median

になります。よって、遺伝子 A では S5 の Normalization 後の Normalized 値で各 Sample の値を、遺

伝子 B では S3 の Normalized 値で各 Sample の Normalized 値を割ります。結果として、遺伝子 A で

は S5 の値が 1.0、遺伝子 B では S3 の値が 1.0 となります。 

 

Normalization を適用した段階では、発現量の絶対レベルによって、Normalized 値が示されます。次に、

Baseline to Median of all samples を適用すると、全ての遺伝子が１の周りの変動に収束してきます。 

 

 

 

S 1 S 2 S 3 S 4 S 5

1

2

3 (Median)
4

5

1

2 3 (Median)

4

5

S 1 S 2 S 3 S 4 S 5

1.0

1.0

Per Gene Normalization:

Normalize to median

適用後

明確なコントロールサンプル
が存在しない場合

図2. Per Gene: Normalize to median

A

B

A

B

Baseline Option 

明確なコントロールサンプルがない場合 

Baseline Option 
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例 2 コントロールサンプルに対する比較実験の場合 

 

コントロールサンプルに対する比較実験の場合は、【Baseline to median of control samples】を適用し

ます。コントロールサンプルの各遺伝子の Normalization 後の Normalized 値で、全 Sample の

Normalized 値を割ります。コントロールサンプルの Normalized 値は１になります。それ以外の Sample 

で１より大きな（小さな）Normalized 値を得れば、その Sample ではコントロールサンプルよりも発現が

高い（低い）ということができます。Baseline to median of control samples の例を図 3 に示します。この

例では、S1 がコントロールサンプルであり、遺伝子 A、B ともに S1 の値で各 Sample の値を割ります。

その結果、遺伝子 A、B は S1 の値が 1.0 になっています。 

 

Median もしくは Specific Sample のどちらを使用した場合も、Baseline Transformation の適用によ

り、全ての遺伝子の Normalized 値は１の周りに収束してきます。 

 

 

 

S 1 S 2 S 3 S 4 S 5 S 1 S 2 S 3 S 4 S 5

1.0

S1が明確なコントロールサンプル

の場合
Per Gene Normalization:

Normalize to Specific Samples

適用後

図3. Per Gene: Normalize to Specific Samples

A

B

A

B

Baseline Option 

Baseline Option 

明確なコントロールサンプルがある場合 



 

遺伝子発現マイクロアレイ 1 色法プロトコル 

 

80 

Appendix7：マイクロアレイのレイアウト 

 

デザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含まれておりま

す。このデザインファイルは、アジレント DNA マイクロアレイスキャナで読み取った向きを基準として作成され

ております。弊社のスキャナはアレイ面を裏側から、またバーコードを左位置で読み取るので、ほとんどの他

社製品のスキャナで読み取ったイメージと向きが異なります。数値化データとプローブ情報を組み合わせる際

には、お使いのスキャナの読み取り方向にあわせて並び替えたデザインファイルをお選び頂く必要があります。

並び替えたデザインファイルも eArray からダウンロードできますので、次の点をよくご確認したうえ、適切なデ

ザインファイルをお使いください。 

 

1) アレイの表面側(front side)からスキャンしているか(バーコードにAgilentの文字がある側からスキャン)。 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。 

縦方向（portrait）にスキャンしたものか。 

バーコードが得られたイメージに対して、上下左右のどこに位置しているか、でご判断ください。 

デザインファイル名には、アレイ種類（Design ID）とファイル更新日の情報が含まれております。 

 

デザインファイル名の例： 

 

 

 

 

 

 
(Design ID) 
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Appendix8：アジレントのゲノミクス製品用ホームページ 

 アジレントのゲノミクス製品用ホームページでは、新製品や最新プロトコル、アプリケーションノートなど様々

な情報を掲載しております。 

(アメリカ本社ウェブサイト)  http://www.genomics.agilent.com/en/home.jsp# 

本社のサイトに掲載してありますキャンペーンの中には、日本国内ではご利用いただけないものもございま

すことをご了承ください。 

 

アジレントゲノミクス 日本ウェブサイト 

 

 

 

 

 

 

 

 

http://www.agilent.com/chem/genomics:jp 

 

• eArray  

• 実験に必要なものリスト 

• サポートページ 

サポートページにて、最新版の和文マニュアルを 

ダウンロードすることができます。 

http://www.agilent.com/chem/genomics:jp


 

遺伝子発現マイクロアレイ 1 色法プロトコル 

 

82 

Copyright Agilent Technologies 2017 

すべての権利は留保されています。著作権法で認められている場合を除き、本書を許可なく複製、改

作、翻訳することは禁止されています。 

 

本和文操作テキストの版権は全て Agilent Technologies, Inc.が所有しています。 

 

ご注意 

本書に記載した内容は、予告なしに変更することがあります。 

本書は、内容について細心の注意をもって作成いたしましたが、万一ご不審な点や誤り、記載もれ等、

お気づきの点がございましたら当社までお知らせください。 

当社では、下記の項目を補償の対象から除外いたします。 

ユーザーの誤った操作に起因する機器などの損傷、性能上のトラブル、損害 

本キットの本来の用途以外の使用に起因する機器などの損傷、性能上のトラブル、損害 

本プロトコル以外の方法または試薬を用いたことによる性能上のトラブル、損害。 

 

分析結果に基づく損失 

本書の内容の一部または全部を無断で複写、転載したり、他の言語に翻訳することは法律で禁止され

ています。複写、転載などの必要が生じた場合は、当社にお問い合わせください。 

本製品パッケージとして提供した本マニュアル等の媒体は本製品用にだけお使いください。 

 

保証 

本書に記載した内容は、予告なしに変更することがあります。 

Agilent Technologies は、本品に関していかなる保証も行いません。これには暗黙の保証、または商品

性および特定目的への適合性が含まれますが、それらに限定されません。 

Agilent Technologies は、本書に含まれている誤植、あるいは本品の性能、または使用に関する偶発

的ないし間接的な損害に関して責任を負いません。 

 

 


